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Chapter 1.

Red Hat Virtualization System
Architecture

A functional Red Hat Virtualization system is multi-layered and is driven by the privileged Red
Hat Virtualization component. Red Hat Virtualization can host multiple guest operating systems.
Each guest operating system runs in its own domain, Red Hat Virtualization schedules virtual
CPUs within the virtual machines to make the best use of the available physical CPUs. Each
guest operating systems handles its own applications. These guest operating systems schedule
each application accordingly.

You can deploy Red Hat Virtualization in one of two choices: full virtualization or
paravirtualization. Full virtualization provides total abstraction of the underlying physical
system and creates a new virtual system in which the guest operating systems can run. No
modifications are needed in the guest OS or application (the guest OS or application is not
aware of the virtualized environment and runs normally). Paravirualization requires user
modification of the guest operating systems that run on the virtual machines (these guest
operating systems are aware that they are running on a virtual machine) and provide
near-native performance. You can deploy both paravirtualization and full virtualization across
your virtualization infrastructure.

The first domain, known as domain0 (dom0), is automatically created when you boot the
system. DomainO is the privileged guest and it possesses management capabilities which can
create new domains and manage their virtual devices. Domain0 handles the physical hardware,
such as network cards and hard disk controllers. Domain0O also handles administrative tasks
such as suspending, resuming, or migrating guest domains to other virtual machines.

The hypervisor (Red Hat's Virtual Machine Monitor) is a virtualization platform that allows
multiple operating systems to run on a single host simultaneously within a full virtualization
environment. A guest is an operating system (OS) that runs on a virtual machine in addition to
the host or main OS.

With Red Hat Virtualization, each guests memory comes from a slice of the host's physical
memory. For paravirtual guests, you can set both the initial memory and the maximum size of
the virtual machine. You can add (or remove) physical memory to the virtual machine at runtime
without exceeding the maximum size you specify. This process is called ballooning.

You can configure each guest with a number of virtual cpus (called vcpus). The Virtual Machine
Manager schedules the vcpus according to the workload on the physical CPUs.

You can grant a guest any number of virtual disks. The guest sees these as either hard disks
or (for full virtual guests) as CD-ROM drives. Each virtual disk is served to the guest from a
block device or from a regular file on the host. The device on the host contains the entire full
disk image for the guest, and usually includes partition tables, multiple partitions, and potentially
LVM physical volumes.

Virtual networking interfaces runs on the guest. Other interfaces can run on the guest like
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virtual ethernet internet cards (VNICs). These network interfaces are configured with a
persistent virtual media access control (MAC) address. The default installation of a new guest
installs the VNIC with a MAC address selected at random from a reserved pool of over 16
million addresses, so it is unlikely that any two guests will receive the same MAC address.
Complex sites with a large number of guests can allocate MAC addresses manually to ensure
that they remain unique on the network.

Each guest has a virtual text console that connects to the host. You can redirect guest logins
and console output to the text console.

You can configure any guest to use a virtual graphical console that corresponds to the normal
video console on the physical host. You can do this for full virtual and paravirtual guests. It
employs the features of the standard graphic adapter like boot messaging, graphical booting,
multiple virtual terminals, and can launch the x window system. You can also use the graphical
keyboard to configure the virtual keyboard and mouse.

Guests can be identified in any of three identities: domain name (domain-name), identity
(domain-id), or UUID. The domain-name is a text string that corresponds to a guest
configuration file. The domain-name is used to launch the guests, and when the guest runs the
same name is used to identify and control it. The domain-id is a unique, non-persistent number
that gets assigned to an active domain and is used to identify and control it. The UUID is a
persistent, unique identifier that is controlled from the guest's configuration file and ensures that
the guest is identified over time by system management tools. It is visible to the guest when it
runs. A new UUID is automatically assigned to each guest by the system tools when the guest
first installs.
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Operating System Support

Red Hat Virtualization's paravirtualization mode allows you to utilize high performance
virtualization on architectures that are potentially difficult to virtualize such as x86 based
systems. To deploy para-virtualization across your operating system(s), you need access to the
paravirtual guest kernels that are available from a respective Red Hat distro (for example, RHEL
4.0, RHEL 5.0, etc.). Whilst your operating system kernels must support Red Hat Virtualization,
it is not necessary to modify user applications or libraries.

Red Hat Virtualization allows you to run an unmodified guest kernel if you have Intel VT and
AMD SVM CPU hardware. You do not have to port your operating system to deploy this
architecture on your Intel VT or AMD SVM systems. Red Hat Virtualization supports:

Intel VT-x or AMD-V Pacifica and Vanderpool technology for full and paravirtualization.

Intel VT-i for ia64

Linux and UNIX operating systems, including NetBSD, FreeBSD, and Solaris.

Microsoft Windows as an unmodified guest operating system with Intel Vanderpool or AMD's
Pacifica technology.

To run full virtualization guests on systems with Hardware-assisted Virtual Machine (HVM),
Intel, or AMD platforms, you must check to ensure your CPUs have the capabilities needed to
do so.

To check if you have the CPU flags for Intel support, enter the following:

grep vnx /proc/cpuinfo

The output displays:

fl ags : fpu tsc ner pae nte cx8 apic ntrr nca cnov pat pse36 clflush dts
acpi mmx fxsr sse sse2 ss ht tmsyscall nx | mconstant_tsc pni nonitor
ds_cpl vnx est tnR cx16 xtpr |ahf_Im

If a vmx flag appears then you have Intel support.

To check if you have the CPU flags for AMD support, enter the following:

grep svm / proc/ cpui nfo
cat /proc/cpuinfo | grep svm
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The output displays:

fl ags : fpu tsc ner pae nte cx8 apic ntrr ncta cnov pat pse36 clflush dt
acpi mmx fxsr sse sse2 ss ht tmsyscall nx mmtext fxsr_opt rdtscp Im
3dnowext pni  cx16 lahf_Im cnp_legacy svm cr8_|egacy

If an svm flag appears then you have AMD support.

note

In addition to checking the CPU flags, you should enable full virtualization within
your system BIOS.
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Hardware Support

Red Hat Virtualization supports multiprocessor systems and allows you to run Red Hat
Virtualization on x86 architectured systems with a P6 class (or earlier) processors like:

» Celeron

e Pentium II
e Pentium llI
e Pentium IV
+ Xeon

* AMD Athlon
e AMD Duron

With Red Hat Virtualization, 32-bit hosts runs only 32-bit paravirtual guests. 64-bit hosts runs
only 64-bit paravirtual guests. And a 64-bit full virtualization host runs 32-bit, 32-bit PAE, or
64-bit guests. A 32-bit full virtualization host runs both PAE and non-PAE full virtualization
guests.

The Red Hat Enterprise Linux Virtualization kernel does not support more than 32GB of memory
for x86_64 systems. If you need to boot the virtualization kernel on systems with more than
32GB of physical memory installed, you must append the kernel command line with men=32G.
This example shows how to enable the proper parameters in the gr ub. conf file:

title Red Hat Enterprise Linux Server (2.6.18-4.elxen)
root (hdO, 0)

ker nel / xen.gz-2.6.18-4-el 5 menr32G

module /vminuz -2.6.18-4.el 5xen ro root =LABEL=/
nodul e /initrd-2.6.18-4. ¢l 5xen.iny

PAE (Physical Address Extension) is a technology that increases the amount of physical or
virtual memory available to user applications. Red Hat Virtualization requires that PAE is active
on your systems. Red Hat Virtualization 32 bit architecture with PAE supports up to 16 GB of
physical memory. It is recommended that you have at least 256 megabytes of RAM for every
guest you have running on the system. Red Hat Virtualization enables x86/64 machines to
address up to physical 64 GB. The Red Hat Virtualization kernels will not run on a non-PAE
system. To determine if a system supports PAE, type the following commands:

grep pae /proc/cpuinfo
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The following output displays:

flags : fpu tsc nsr pae nte cx8 apic nmirr nca cnov pat pse36 mmx fxsr sse
syscal | mmtext 3dnowext 3dnow up ts

If your output matches (or is similar to) the above, then your CPU supports PAE. If the
command prompt displays nothing, then your CPU does not support PAE.
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Red Hat Virtualization System
Requirements

The items listed below are required by the Red Hat Virtualization system:

* A working Red Hat RHEL 5 Linux distribution
» A working GRUB bootloader

* Root access

» A P6 class (or earlier) processor

* The Linux bridge-utils

e The Linux hotplug systems

* zlib development installation

e Python 2.2 runtime

* initscripts

The dependencies are configured automatically during the installation process.

Note

If your system CPU architecture is ia64, you need to manually install the

xen-i a64- guest - fi r mvar e package to run a fully virtualized guest. This
package is provided in the Supplementary CD and is not installed by default.







Chapter 5.

Booting the System

After installing the Red Hat Virtualization components, you must reboot the system. When the
boot completes, you must log into your system as usual. Then before you start Red Hat
Virtualization you must log in a root. The xend control daemon should already be initiated by
initscripts, but to start the xend manually, enter:

servi ce xend start

You can also use chkconfi g xend when installing to enable xend at boot time.

The xend node control daemon performs system management functions that relate to virtual
machines. This daemon controls the virtualized resources, and xend must be running to interact
with virtual machines. Before you start xend, you must specify the operating parameters by
editing the xend configuration file xend-config.sxp which is located in the etc/xen directory.
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Chapter 6.

Configuring GRUB

GNU Grand Unified Boot Loader (or GRUB) is a program which enables the user to select
which installed operating system or kernel to load at system boot time. It also allows the user to
pass arguments to the kernel. The GRUB configuration file (located in / boot / gr ub/ gr ub. conf)
is used to create a list of operating systems to boot in GRUB's menu interface. When you install
the kernel-xen RPM, a post script adds kernel-xen entries to the GRUB configuration file. You
can edit the gr ub. conf file and enable the following GRUB parameter:

title Red Hat Enterprise Linux Server (2.6.18-3.el5xen)

r oot (hdO; 0)

kernel /xen.gz.-2.6.18-3.el5

nmodul e /vm inuz-2.6..18-3. el 5xen ro root=/dev/ Vol G oup00/ LogVol 00 rhgb
qui et

modul e /initrd-2.6.18-3. el 5xenxen.ing

If you set your Linux grub entries to reflect this example, the boot loader loads the hypervisor,
initrd image, and Linux kernel. Since the kernel entry is on top of the other entries, the kernel
loads into memory first. The boot loader sends (and recieves) command line arguments to and
from the hypervisor and Linux kernel. This example entry shows how you would restrict the
DomainO linux kernel memory to 800 MB:

title Red Hat Enterprise Linux Server (2.6.18-3.el5xen)

r oot (hd0; 0)

kernel /xen.gz.-2.6.18-3.¢el5 donD_nenm=800M

modul e /vm inuz-2.6..18-3. el 5xen ro root=/dev/ Vol G oup00/ LogVol 00 rhgb
qui et

nmodul e /initrd-2.6.18-3. el 5xenxen.ing

You can use these GRUB parameters to configure the Virtualization hypervisor:

This limits the amount of memory that is available for domainO.

conl=115200, 8nl

This enables the first serial port in the system to act as serial console (com2 is assigned for the
next port, and so on...).

11
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donD_nem

This limits the amount of memory that is available for domainO.

donD_nax_vcpus

This limits the amount of CPUs visible to domainO.

acpi

This switches the ACPI hypervisor to the hypervisor and domainO. The ACPI parameter options
include:

[* **** Linux config options: propagated to domain0 ****/

[* "acpi =of f": Di sabl es both ACPI table parsing and interpreter. */
/* "acpi =force": Overrides the disable blacklist. */
[ * "acpi =strict": Di sabl es out - of - spec wor kar ounds. */
/* "acpi =ht": Limts ACPI fromboot-tine to enable HI. */
[ * "acpi =noirq": Di sabl es ACPlI interrupt routing. */
noacpi

This disables ACPI for interrupt delivery.

12



Chapter 7.

Booting a Guest Domain

You can boot guest domains by using the xmapplication. You can also use vi r sh and the
Virtual Machine Manager to boot the guests. A prerequisite for booting a guest domain is to
install a guest host first. This example uses the xmcreate subcommand:

# xmcreate -c guestdonmainl

The guest domai n1 is the configuration file for the domain you are booting. The - ¢ option
connects to the actual console after booting.

13
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Chapter 8.

Starting/Stopping a Domain at Boot
Time

You can start or stop running domains at any time. Domain0 waits for all running domains to
shutdown before restarting. You must place the configuration files of the domains you wish to
shut down in the / et c/ xen/ directory. All the domains that you want to start at boot time must
be symlinked to / et ¢/ xen/ aut o

chkconfi g xendomai ns on

The chkconfi g xendomai ns on command does not automatically start domains; instead it will
start the domains on the next boot.

chkconfi g xendomnai ns of f

Terminates all running Red Hat Virtualization domains. The chkconfi g xendomai ns of f
command shuts down the domains on the next boot.

15
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Chapter 9.

Configuration Files

Red Hat Virtualization configuration files contain the following standard variables. Configuration
items within these files must be enclosed in quotes ("). These configuration files reside in the
/ et c/ xen directory.

Item Description

pae Specifies the physical address extention
configuration data.

apic Specifies the advanced programmable
interrupt controller configuration data.

memory Specifies the memory size in megabytes.
vcpus Specifies the numbers of virtual CPUs.
console Specifies the port numbers to export the

domain consoles to.

nic Specifies the number of virtual network
interfaces.
vif Lists the randomly-assigned MAC addresses

and bridges assigned to use for the domain's
network addresses.

disk Lists the block devices to export to the
domain and exports physical devices to
domain with read only access.

dhcp Enables networking using DHCP.

netmask Specifies the configured IP netmasks.
gateway Specifies the configured IP gateways.

acpi Specifies the advanced configuration power

interface configuration data.

Table 9.1. Red Hat Virtualization Configuration Files

17
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Chapter 10.

Managing CPUs

Red Hat Virtualization allows a domain's virtual CPUs to associate with one or more host CPUs.
This can be used to allocate real resources among one or more guests. This approach allows
Red Hat Virtualization to make optimal use of processor resources when employing dual-core,
hyperthreading, or other advanced CPU technologies. If you are running I/O intensive tasks, its
typically better to dedicate either a hyperthread or entire core to run domain0. The Red Hat
Virtualization credit scheduler automatically rebalances virtual cpus between physical ones, to
maximize system use. The Red Hat Virtualization system allows the credit scheduler to move
CPUs around as necessary, as long as the virtual CPU is pinned to a physical CPU.

19
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Chapter 11.

Migrating a Domain

Migration is the transferal of a running virtual domain from one physical host to another. Red
Hat Virtualization supports two varieties of migration — offline and live. Offline migration moves
a virtual machine from one host to another by pausing it, transferring its memory, and then
resuming it on the host destination. Live migration does the same thing, but does not directly
affect the domain. When performing a live migration, the domain continues its usual activities,
and from the user perspective is unnoticeable. To initiate a live migration, both hosts must be
running Red Hat Virtualization and the xend daemon. The destinations host must have sufficient
resources (such as memory capacity) to accommodate the domain bandwidth after the
migration. Both the source and destination machines must have the same architecture and
virtualization extensions (such as i386-VT, x86-64-VT, x86-64-SVM, etc.) and must be on the
same L2 subnet.

When a domain migrates its MAC and IP addresses move with it. Only virtual machines with the
same layer-2 network and subnets will successfully migrate. If the destination node is on a
different subnet, the administrator must manually configure a suitable EtherlP or IP tunnel in the
remote node of domain0. The xend daemon stops the domain and copies the job over to the
new node and restarts it. The Red Hat Virtualization RPM does not enable migration from any
other host except the localhost (see the /etc/xend-config.sxp file for information). To allow the
migration target to accept incoming migration requests from remote hosts, you must modify the
target's xen-relocation-hosts-allow parameter. Be sure to carefully restrict which hosts are
allowed to migrate, since there is no authentication.

Since these domains have such large file allocations, this process can be time consuming. If
you migrate a domain with open network connections, they will be preserved on the host
destination, and SSH connections should still function. The default Red Hat Virtualization
iptables rules will not permit incoming migration connections. To allow this, you must create
explicit iptables rules.

You can use the xm migrate command to perform an offline migration :
xm m grate dommin-id [destination donain]
You can use the xm migrate command to perform a live migration:

xm mgrate domain-id -1 [destination donain]

You may need to reconnect to the domain's console on the new machine. You can use the xm
console command to reconnect.

21
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Chapter 12.

Configuring for Use on a Network

Integrating Red Hat Virtualization into your network architecture is a complicated process and
depending upon your infrastructure, may require custom configuration to deploy multiple
ethernet interfaces and setup bridging.

Each domain network interface is connected to a virtual network interface in donD by a point to
point link. These devices are vi f <donmi d> and <vi fi d>. vi f 1. 0 for the first interface in domain
1;vif3.1 forthe second interface in domain 3.

Domain0 handles traffic on these virtual interfaces by using standard Linux conventions for
bridging, routing, rate limiting, etc. The xend daemon employs two shell scripts to perform initial
configuration of your network and new virtual interfaces. These scripts configure a single bridge
for all virtual interfaces. You can configure additional routing and bridging by customizing these
scripts.

Red Hat Virtualization's virtual networking is controlled by the two shell scripts, net wor k- bri dge
and vi f - bri dge. xend calls these scripts when certain events occur. Arguments can be passed
to the scripts to provide additional contextual information. These scripts are located in the

/ etc/ xen/ scri pts directory. You can change script properties by modifying the
xend-config.sxp configuration file located in the / et c/ xen directory.

net wor k- br i dge — When xend is started or stopped, this script initializes or shuts down the
virtual network. Then the configuration initialization creates the bridge xen—br 0 and moves et h0
onto that bridge, modifying the routing accordingly. When xend finally exits, it deletes the bridge
and removes et h0, thereby restoring the original IP and routing configuration.

vi f - bri dge is a script that is invoked for every virtual interface on the domain. It configures
firewall rules and can add the vi f to the appropriate bridge.

There are other scripts that you can use to help in setting up Red Hat Virtualization to run on
your network, such as net wor k- r out e, net wor k- nat , vi f-rout e, and vi f - nat . Or these
scripts can be replaced with customized variants.
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Chapter 13.

Securing DomainO

When deploying Red Hat Virtualization on your corporate infrastructure, you must ensure that
domain0 cannot be compromised. DomainO is the privileged domain that handles system
management. If domain0 is insecure, all other domains in the system are vulnerable. There are
several ways to implement security you should know about when integrating Red Hat
Virtualization into your systems. Together with other people in your organization,you should
create a 'deployment plan' that contains the operating specifications and services that will run
on Red Hat Virtualization, and what is needed to support these services. Here are some
security issues to consider when putting together a deployment plan:

* Run the lowest number of necessary services. You do not want to include too many jobs and
services in domain0. The less things running on domain0, the higher the level of security.

« Enable SeLINUX to help secure domainO.

» Use a firewall to restrict traffic to domain0. You can setup a firewall with default-reject rules
that will help secure attacks on domainO. It is also important to limit network facing services.

« Do not allow normal users to access domainO. If you do permit normal users domainQ access,
you run the risk of rendering domainO vulnerable. Remember, domainO is privileged, and
granting unprivilged accounts may compromise the level of security.
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Chapter 14.

Storage

There are several ways to manage virtual machine storage. You can export a domainO physical
block device (hard drive or partition) to a guest domain as a virtual block device (VBD). You can
also export directly from a partitioned image as a file-backed VBD. Red Hat Virtualization
enables LVM and blktap by default during installation. You can also employ standard network
protocols such as NFS, CLVM, or iSCSI to provide storage for virtual machines.

27



28



Chapter 15.

Managing Virtual Machines with
Virsh

You can use the virsh application to manage virtual machines. This utility is built around the
libvirt management API and operates as an alternative to the xm tool or the graphical Virtual
Machine Manager. Unprivileged users can employ this utility for read-only operations. If you
plan on running xend/ genu, you should enable xend/ gemu to run as a service. After modifying
the respective configuration file, reboot the system, and xend/ gemu will run as a service. You
can use virsh to script vm work. Like the xm tool, you run virsh from the command line.

1. Connecting to a Hypervisor

You can use virsh to initiate a hypervisor session:
virsh connect <name>

Where <nane> is the machine name of the hypervisor. If you want to initiate a read—only
connection, append the above command with — eadonl y.

2. Creating a Virtual Machine

You can make a new virtual machine session from an XML machine definition. If you have a
pre-existing guest that you created previously with the xm tool, you can also create a virtual
machine for it:

virsh create <path to XM. configuration file>

3. Configuring an XML Dump

You can use virsh to perform a data dump for an existing virtual machine.
virsh dunpxm [domain-id | domain-name | domai n-uui d]

This command outputs the domain information (in XML) to st dout . If you save the data to a
file, you can use the cr eat e option to recreate the virtual machine.

4. Suspending a Virtual Machine

You can use virsh to suspend a domain:
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vi rsh suspend [donmin-id | donmi n-nane | domai n- uui d]

When a domain is in a suspended state, it still consumes system RAM. There will also be no
disk or network I/0O when suspended. This operation is immediate and the virtual machine must
be restarted with the r esune option .

5. Resuming a Virtual Machine

You can use virsh to restore a suspended virtual machine:
virsh resune [domain-id | domai n-name | domai n-uui d]

This operation is immediate and the virtual machine parameters are preserved in a suspend
and resune cycle.

6. Saving a Virtual Machine

You can use virsh to save the current state of a virtual machine to a file:
vi rsh save [domai n-nane] [domai n-id | domai n-uuid][fil enanme]

This stops the virtual machine you specify and saves the data to a file, which may take some
time given the amount of memory in use by your virtual machine. You can restore the state of
the virtual machine with the r est or e option .

7. Restoring a Virtual Machine

You can use virsh to restore a virtual machine that you previously saved with the vi rsh save
option :

virsh restore [fil enane]

This restarts the saved virtual machine, which may take some time. The virtual machine's name
and UUID are preserved but are allocated for a new id.

8. Shutting Down a Virtual Machine

You can use virsh to shut down a virtual machine:

vi rsh shutdown [domain-id | domai n-nane | donai n-uui d]
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Rebooting a Virtual Machine

You can control the behavior of the rebooting virtual machine by modifying the on_shut down
parameter of the xnmdomai n. cf g file.

9. Rebooting a Virtual Machine

You can use virsh to reboot a virtual machine:
virsh reboot [donmin-id | domain-nanme | donmi n-uuid]

You can control the behavior of the rebooting virtual machine by modifying the on_r eboot
parameter of the xndonai n. cf g file.

10. Terminating a Domain

You can use virsh to terminate a virtual machine:
virsh destroy [domain-nanme | dommin-id | domai n-uuid]

This command does an immediate ungraceful shutdown and stops any guest domain sessions
(which could potentially lead to file corruptted filesystems still in use by the virtual machine). You
should use the dest r oy option only when the virtual machine's operating system is
non-responsive. For a paravirtualized virtual machine, you should use the shut down option .

11. Converting a Domain Name to a Domain ID

You can use virsh to convert a domain name or UUID to a domain id:

virsh dom d [domai n-nanme | domai n- uui d]

12. Converting a Domain ID to a Domain Name

You can use virsh to convert a domain id or UUID to a domain name:

vi rsh domane [ domai n-nane | donai n- uui d]

13. Converting a Domain Name to a UUID
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You can use virsh to convert a domain name to a UUID:

virsh donmuui d [domain-id | domai n-uui d]

14. Displaying Virtual Machine Information

You can use virsh to display information for a given virtual machine identified by its domain ID,
domain name, or UUID:

virsh dom nfo [domain-id | donmai n-nane | domai n-uui d]

15. Displaying Node Information

You can use virsh to display node information:
vi rsh nodei nfo

The outputs displays something similar to:

CPU nodel x86_64
CPU (s) 8

CPU frequency 2895 Mhz
CPU socket ('s) 2

Core(s) per socket 2

Thr eads per core: 2

Numa cel | (s) 1

Menory si ze: 1046528 kb

This displays the node information and the machines that support the virtualization process.

16. Displaying the Virtual Machines

You can use virsh to display the virtual machine list and the current state:
virsh |list domain-name [ —+nactive | —-all]

The —inact i ve option lists inactive domains (domains that have been defined but are not
currently active). The —-al | domain lists all domains, whether active or not. Your output
should resemble the this example:

32



Displaying Virtual CPU Information

I D Narmre State

0 Domai n0 runni ng
1 Donmai n202 paused

2 Domai n010 i nactive
3 Domai n9600 crashed

Here are the six domain states:

running |ists domains currently active on the CPU
bl ocked I|ists donmins that are bl ocked
paused lists domains that are suspended

shutdown |ists donmmins that are in process of shutting down
shutoff |ists domains that are conpletely down.

crashed lists domains that are crashed

17. Displaying Virtual CPU Information

You can use virsh to display virtual CPU information from a virtual machine:

virsh vcpuinfo [domai n-id | domai n-nanme | domai n-uui d]

18. Configuring Virtual CPU Affinity

You can use virsh to configure the affinity of virtuals CPUs with physical CPUs:
virsh vcpupin [domain-id | domai n-name | domain-uuid] [vcpu] , [cpulist]

Where [ vcpu] is the virtual VCPU number and [ cpul i st] lists the physical number of CPUs.

19. Configuring Virtual CPU Count

You can use virsh to modify a Virtual Machine's number of CPUs:

vi rsh setvcpus [donai n-name | domain-id | domai n-uuid] [count]
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Note that the new count cannot exceed the amount you specified when you created the Virtual
Machine.

20. Configuring Memory Allocation

You can use virsh to modify a domain's memory allocation:
virsh setnem [donmin-id | domai n-nane] [count]

You must specify the [ count] in kilobytes. Note that the new count cannot exceed the amount
you specified when you created the Virtual Machine. Values lower than 64 MB probably won't
work. You can adjust the Virtual Machine memory as necessary.

21. Configuring Maximum Memory

You can use virsh to modify a Virtual Machine's maximum memory:
virsh set nexmem [domai n-name | domain-id | donmin-uuid] [count]

You must specify the [count] in kilobytes. Note that the new count cannot exceed the amount
you specified when you created the Virtual Machine. Values lower than 64 MB probably won't
work. The maximum memory doesn't affect the current use of the Virtual Machine (unless the
new value is lower which should shrink memory usage).

22. Managing Virtual Networks

You can use virsh to manage virtual networks. To list virtual networks:
virsh net-1list
This command generates output similar to:

[root @omain ~]# virsh net-1list

Name State Aut ost art
def aul t active yes

vnet 1 active yes

vnet 2 active yes

To view network information for a specific virtual network:
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virsh net-dunpxml [vnet nane]

This displays information about a specified virtual network in XML format:

[root @omain ~]# virsh net-dunmpxm vnetl
<net wor k>
<nane>vnet 1</ nane>
<uui d>98361b46- 1581- ach7- 1643- 85a412626e70</ uui d>
<forward dev='eth0' />
<bri dge name='vnet0' stp='"on' forwardDel ay="'0" />
<i p address='192.168.100. 1" net mask='255. 255. 255. 0' >
<dhcp>
<range start='192.168. 100. 128' end='192. 168. 100. 254' />
</ dhcp>
</ip>
</ net wor k>

Other virsh commands used in managing virtual networks are:

e virsh net-autostart [network name] — Autostart a network specified as [network name]

e virsh net-create [ XML fil e] — Generates and starts a hew network using a preexisting
XML file

e virsh net-define [ XML fil e] — Generates a new network from a preexisting XML file
without starting it

e virsh net-destroy [network name] — Destroy a network specified as [network name]
e virsh net-name [network UU D] — Convert a specified [network UUID] to a network name
e virsh net-uuid [network nanme — Convert a specified [network name] to a network UUID

e virsh net-start [name of an inactive network] — Starts a previously undefined
inactive network

e virsh net-undefine [nane of an inactive network] — Undefine an inactive network

35



36



Chapter 16.

Managing Virtual Machines Using
xend

The xend node control daemon performs certain system management functions that relate to
virtual machines. This daemon controls the virtualized resources, and xend must be running to
interact with virtual machines. Before you start xend, you must specify the operating parameters
by editing the xend configuration file xend- conf i g. sxp which is located in the et c/ xen
directory. Here are the parameters you can enable or disable in the xend- confi g. sxp
configuration file:

Item Description

console-limit Determines the console server's memory
buffer limit and assigns values on a
per-domain basis

min-mem Determines the minimum number of
megabytes that is reserved for domainO (if
you enter 0, the value does not change)

domO cpus Determines the number of CPUs in use by
domainO (at least 1 CPU is assigned by
default)

enable-dump Determines that a crash occurs then enables

a dump (default is 0)

external-migration-tool Determines the script or application that
handles external device migration (scripts
must reside in
etc/ xen/ scripts/external -device-nmigrate

logfile Determines the location of the log file (default
is/var /1 og/ xend. | og)

loglevel Filters out the log mode values: DEBUG,
INFO, WARNING, ERROR, or CRITICAL
(default is DEBUG)

network-script Determines the script that enables the
networking environment (scripts must reside
in et c/ xen/ scri pts directory)

xend-http-server Enables the http stream packet management
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Item Description

server (default is no)

xend-unix-server Enables the unix domain socket server (a
socket server is a communications endpoint
that handles low level network connections
and accepts or rejects incoming connections)

xend-relocation-server Enables the relocation server for
cross-machine migrations (default is no)

xend-unix-path Determines the location where the
xend- uni x- ser ver command outputs data
(defaultis var/1i b/ xend/ xend- socket )

xend-port Determines the port that the http management
server uses (default is 8000)

xend-relocation-port Determines the port that the relocation server
uses (default is 8002)

xend-relocation-address Determines the virtual machine addresses
that are allowed for system migration

xend-address Determines the address that the domain
socket server binds to.

Table 16.1. Red Hat Virtualization xend Configuration Parameters

After setting these operating parameters, you should verify that xend is running and if not,
initilize the daemon. At the command prompt, you can start the xend daemon by entering the
following:

servi ce xend start

You can use xend to stop the daemon:

servi ce xend stop

This stops the daemon from running.
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You can use xend to restart the daemon:

service xend restart

The daemon starts once again.

You check the status of the xend daemon.

servi ce xend status

The output displays the daemon's status.
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Chapter 17.

Managing Virtual Machines with
Virtual Machine Manager

This section describes the Red Hat Virtualization Virtual Machine Manager (VMM) windows,
dialog boxes, and various GUI controls.

1. Virtual Machine Manager Architecture

Red Hat Virtualization is a collection of software components that work together to host and
manage virtual machines. The Virtual Machine Manager (VMM) gives you a graphical view of
the virtual machines on your system. You can use VMM to define both para-virtual and full
virtual machines. Using Virtual Machine Manager, you can perform any number of virtualization
management tasks including assigning memory, assigning virtual CPUs, monitoring operational
performance, and save, restore, pause, resume, and shutdown virtual systems. It also allows
you to access the textual and graphical console. Red Hat Virtualization abstracts CPU and
memory resources from the underlying hardware and network configurations. This enables
processing resources to be pooled and dynamically assigned to applications and service
requests. Chip-level virtualization enables operating systems with Intel VT and AMD Pacifica
hardware to run on hypervisors.

2. The Open Connection Window

This window appears first and prompts the user to choose a hypervisor session. Non-privileged
users can initiate a read-only session. Root users can start a session with full blown read-write
status. For normal use, select the Local Xen host option. You start the Virtual Machine
Manager test mode by selecting the Other hypervisor and then type test:///def aul t inthe
URL field beneath. Once in test mode, you can connect to a libvirt dummy hypervisor. Note that
although the Remote Xen host screen is visible, the functionality to connect to such a host is
not implemented into Red Hat Enterprise Linux 5.1.
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! Open connection x

@ lLocal Xen host

() Other hypervisor

|| Read only connection

‘ ¥ Cancel } {@Cunnect

Figure 17.1. Virtual Machine Manager Connection window

3. Virtual Machine Manager Window

This main window displays all the running virtual machines and resources currently allocated to
them (including domain0). You can decide which fields to display. Double-clicking on the
desired virtual machine brings up the respective console for that particular machine. Selecting a
virtual machine and double-click the Details button to display the Details window for that
machine. You can also access the File menu to create a new virtual machine.

n. Virtual Machine Manager =kl
File Edit View Help

View:
D] Mame ¥ Status CPU usage VCPUs  Mermory usage i
0  Domain-0 g Running 0.23 % 8 926.37 MB (90.64%) [ |

Figure 17.2. Virtual Machine Manager main window
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Virtual Machine Graphical Console

4. Virtual Machine Details Window

This window displays graphs and statistics of a guest's live resource utilization data available
from the Red Hat Virtualization Virtual Machine Manager. The UUID field displays the globally
unigue identifier for the virtual machines(s).

Domain-0 Virtual Machine Details

Virtual Machine Miew

Basic details =

Narne:
UuID:
Status: g JRunning

Performance

CPU usage: 1%

Memory usage: 926 MB of 1022 MBE

Figure 17.3. Virtual Machine Manager Details window

5. Virtual Machine Graphical Console

This window displays a virtual machine's graphical console. Paravirtual and full virtual machines
use different techniques to export their local virtual framebuffers, but both technologies use
VNC to make them available to the Virtual Machine Manager's console window. If your virtual
machine is set to require authentication, the Virtual Machine Graphical console prompts you for
a password before the display appears.
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| ol ol WIFCUa  Miachsne Comeole [ :--'l'"

Yinwal Machineg Hidp

T (e Fiv') &

Pass  Shiidewn Opin lemina  Take snapshal  Machine dicals

Figure 17.4. Graphical Console window

Your local desktop can intercept key combinations (for example, Ctrl+Alt+F11) to prevent them
from being sent to the guest machine. You can use the Virtual Machine Manager's 'sticky key'
capability to send these sequences. You must press any modifier key (like Ctrl or Alt) 3 times
and the key you specify gets treated as active until the next non-modifier key is pressed. Then
you can send Ctrl-Alt-F11 to the guest by entering the key sequence 'Ctrl Ctrl Ctrl Alt+F1".

6. Starting the Virtual Machine Manager

To start the Virtual Machine Manager session, from the Appl i cati ons menu, click Syst em

Tool s and select Vi rt ual Machi ne Manager

The Virtual Machine Manager main window appears.
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Virtual Machine Manager

File Edit View Help

View:
9] Name ¥ Status CPU usage VCPUs Mermory usage il
0  Domain-0 & Running 0.23 % 8 926.37 MB (90.64%) [ |

Figure 17.5. Starting the Virtual Machine Manager

7. Creating a New Virtual Machine

The Virtual Machine Manager (virt-manager) is the desktop application that manages virtual
machines.

You can use Red Hat's Virtual Machine Manager to:

+ Create new domains.

 Configure or adjust a domain's resource allocation and virtual hardware.

« Summarize running domains with live performance and resource utilization statistics.
« Display graphs that show performance and resource utilization over time.

» Use the embedded VNC client viewer which presents a full graphical console to the guest
domain.

Note:

You must install Red Hat Enterprise Linux 5.1, virt-manager, and the kernel

packages on all systems that require virtualization. All systems then must be
booted and running the Red Hat Virtualization kernel.

These are the steps required to install a guest operating system on Red Hat Enterprise Linux 5
using the Virtual Machine Monitor:
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Procedure 17.1. Creating a Guest Operating System

1. From the Applications menu, select System Tools and then Virtual Machine Manager.

The Virtual Machine Manager main window appears.

L

a4 Virtual Machine Manager
Hle Edit View Help
View:| All virtual machines hd
ID |Name + |Status CPU usage Memory usage ad
0  Domain-0 & Running 7.08 % | 93950 mB (91 84%) [N
o
-
]
] i [+]
Delete [§ New ﬁDe‘gaiIS Open

Figure 17.6. Virtual Machine Manager window

2. From the File menu, select New machine.
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.
il Edit view Help

Virtual Machine Manager el

E MNew machine... Alt4+N View:
27 Restore saved machine... Alt+R
= VCPUs | Memory usage
=l Open connection... 3 926.37 MB (90.64%) I
% Close Ctrl+W
ig] Quit Ctri+Q )
| [ New || ¢/ Details || 7 Open |

Figure 17.7. Selecting a New Machine

The Creating a new virtual system wizard appears.

3. Click Forward.

® A name for your new virtual system

Whether the system will be Fully

= virtualized or para-virtualized

The location of the files necessary for installing an
operating system on the virtual system

Storage details - which disk partitions or
files the system should use

® Memory and CPU allocation

L4 Create a new virtual system

Creating a new virtual system

This assistant will guide you through creating a new
virtual system. You will be asked for sorme information
about the virtual system you'd like to create, such as:

¥ Cancel

-

43 Back

» Eurwaﬁ

Figure 17.8. Creating a New Virtual System Wizard
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4.

5.

Enter the name of the new virtual system and then click Forward.

K% Create a new virtual system

System Name: xen-guezﬂ

() Example: systeml

-

Please choose a name for your virtual syster:

Naming your virtual system

¥ Cancel

4 Back

(=3 Eurwaj

Figure 17.9. Naming the Virtual System

Enter the location of your install media. Location of the kickstart file is optional. Then click

Forward .
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b4 Create a new virtual system

Locating installation media

Please indicate where installation media is available for the
operating systern you would like to install on this
paravirtualized virtual systermn. Optionally you can provide
the URL for a kickstart file that describes your system:

Install Media URL: http:Hbuildmut.example.cumfdistmﬁsﬁftreel »

o Example: http://servername. example com/distrofi386/tree

Kickstart URL: b

o Example: ftp://hostname. example.com/ks/ks.cfg

L % Cancel| | 4@ Back| | & Eurwaj

Figure 17.10. Locating the Installation Media

6. Install either to a physical disk partition or install to a virtual file system within a file.

Note

This example installs a virtual system within a file.

SELinux policy only allows xen disk images to reside in / var/ | i b/ xen/ i nages.

Open a terminal and create the /xen directory and set the SELinux policy with the command
restorecon -v /xen. Specify your location and the size of the virtual disk, then click
Forward.
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7.

b4 Create a new virtual system

Assighing storage space

Please indicate how you'd like to assign space on this physical
host system for your new virtual system. This space will be

used to install the virtual systerm's operating system.

() Normal Disk Partition:

Partition: Browse .

D Example: /dev/hdc2

(® Simple File:

File Location: | fivar/lib/xen Browse. ..

File Size: 000 |~ MB
D Mote: File size parameter is only relevant for new files

Tip: You may add additional storage, including network-
mounted storage, to your virtual system after it has been
created using the same tools you would on a physical system.

L % Cancel| | @ Back| | & Eurwaj

Figure 17.11. Assigning the Storage Space

Select memory to allocate the guest and the number of virtual CPUs then click Forward.
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b4 Create a new virtual system

Allocate memory and CPU

Memory:

Please enter the memory configuration for this VM. You can
specify the maximum amount of memaory the VM should be
able to use, and optionally a lower amount to grab on startup.

Total memory on host machine: 1023 GB
WM Max Mermory: 512
VM Startup Memory: [512| |-

CPUs:
Please enter the number of virtual CPUs this WM
should start up with.

Physical host CPUs: 1

VCPUs: |1 [*

Tip: For best performance, the number of virtual CPUs should be less
than (or equal to) the number of physical CPUs on the host system.

oy

L % Cancel| | 4@ Back| | & Eurwaj

Figure 17.12. Allocating Memory and CPU

8. Select Forward to open a console and the files start to install.
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(v xen-guest Virtual Machine Console
Virtual Machine View

2 n d

Run Pause Shutdown
miform Multi-Platform E-IDE driver Revision: ?7.88alpha2

ide-f loppy driver B.99.newide
1zbcore: registered new driver libusual
izbcore: registered new driver hiddev
izhcore: registered new driver usbhid
rivers-usb~input-/hid-core.c: vZ.6:USB HID core driver
NP: Mo P3-/Z2 controller found. Probing ports directly.
iG842.c: No controller found.
ice: P5/2 mouse device common for all mice
:md driver 8.98.3 MAXx_MD_DEUS=256, MD_SE_DISKS=27
: bitmap version 4.39
P bic registered
Initializing IPsec netlink socket
ET: Registered protocol family 1
ET: Registered protocol family 17
zing IPI No-Shortcut mode
XENBUS: Device with no driver: devicersvbd- 51712
XENBUS: Device with no driver: devicervif.-B
Freeing unused kernel memory: 188k freed
ite protecting the kernel read-only data: 350k
Greetings.
naconda installer init verszion 11.2 starting
opunting ~proc filesystem... done
reating ~dev filesystem... done
opunting sdevspts (unixd8 pty) filesystem... domne
ounting ~sys filesystem... done
rying to remount root filesystem read write... dome
punting ~tmp as ramfs... done
wnning install...
rumning ~sbin-loader

ide: Assuming 58MHz system bus speed for PI0 modes: override with idebus=xx

L

Figure 17.13. Allocating Memory and CPU

Complete your installation in the window provided.
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hd xen-guest Virtual Machine Console

Virtual Machine \iew

» n o

Run Fause Shutdown

RED HAT
ENTERPRISE LINUX 5

RED HAT
ENTERPRISE LINUX 5

[ ) Release Notes

<]

Figure 17.14. Installation Begins...

Warning

When installing Red Hat Enterprise Linux 5.1 on a fully virtualized guest, do not
use the ker nel - xen kernel. Using this kernel on fully virtualized guests can
cause your system to hang.

If you are using an Installation Number when installing Red Hat Enterprise Linux

5.1 on a fully virtualized guest, be sure to deselect the Vi rt ual i zat i on package
group during the installation. The Vi rt ual i zat i on package group option installs
the ker nel - xen kernel.

Note that paravirtualized guests are not affected by this issue. Paravirtualized
guests always use the ker nel - xen kernel.

10. Type xm create -c xen-guest to start the Red Hat Enterprise Linux 5.1 guest. Right click
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on the guest in the Virtual Machine Manager and choose Open to open a virtual console.

99 on-oue =[E%

Virtual Machine \iew

P n o

Run Pause Shutdown

RED HAT

ENTERPRISE LINUX 5

Username:

Please enter your username

Language Session Restart Shut Down

Figure 17.15. Red Hat Enterprise Linux 5.1 (guest)

11. Enter user name and password to continue using the Virtual Machine Manager.

8. Restoring A Saved Machine

After you start the Virtual Machine Manager, all virtual machines on your system are displayed
in the main window. DomainO is your host system. If there are no machines present, this means
that currently there are no machines running on the system.

To restore a previously saved session:

1. From the File menu, select Restore a saved machine.
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) Virtual Machine Mg
Edit Miew Help
New machine... Alt+N
¥ Restore saved machine... Alt+R
- - : WCPU
Restore a saved machine from a filesystem image
% Close Ctri4+W
ﬂ Quit Ctri+Q
Figure 17.16. Restoring a Virtual Machine
2. The Restore Virtual Machine main window appears.
|" 1] Restore Virtual Machine x
‘ Dl home || bclaary‘
Places Name ¥  Modified | (|
i@ root ‘ii Desktop :
& Desktop [ZJ OpenOffice 10/25/2006
= virtualization 10/25/2006
[} configuring Virsh 10/31/2006
‘E] Configuring Virsh.xmil Thursday ||=
- [J Configuring Virsh.xml~ 11/01/2006
[J Configuring Virsh~ 10/31/2006
[ Red Hat Virtualization Troubleshooting 10/26/2006
| ] Red Hat Virtualization Troubleshooting.xml 10/27/2006
. |[J Red Hat Virtualization Troubleshooting.x... 10/26/2006
4 Add m Bemove ‘ {7 Red Hat Virtualization Troubleshooting~  10/26/2006 ||~
[ ¥ cancel l l {7 Open l

Figure 17.17. Selecting Saved Virtual Machine Session
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3. Navigate to correct directory and select the saved session file.
4. Click Open.

The saved virtual system appears in the Virtual Machine Manager main window.

Virtual Machine Manager

File Edit View Help

View:
] Name ™ Status CPU usage VCPUs Memory usage i
0  Domain-0 & Running 0.23 % 8 926.37 MB (90.64%) [ |

Figure 17.18. The Restored Virtual Machine Manager Session

9. Displaying Virtual Machine Details

You can use the Virtual Machine Monitor to view activity data information for any virtual
machines on your system.

To view a virtual system's details:

1. Inthe Virtual Machine Manager main window, highlight the virtual machine that you want to
view.
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! Virtual Machine Manager = ||ET|[*
File Edit Miew Help
Eiew:| |
o] Mame ¥ Status CPU usage VCPUs Memory usage
0  Domain-0 & Running 0.23 % 8 926.37 MB (90.64%) [ |
(<] I D
) || [ New || & || =, |

Figure 17.19. Selecting Virtual Machine to Display

From the Virtual Machine Manager Edit menu, select Machine Details (or click the Details
button on the bottom of the Virtual Machine Manager main window).

Virtual Machine Manager (Xen: localhostlocaldomain)

=181 View Help

Host details... giew:[AlI virtual machines ¢l

+ Machine details...

CPU usage VCPUs  Memory usage

38 Preferences

® H 3 New ” o Details H 'EE?QDEHJI

Figure 17.20. Displaying Virtual Machine Details Menu

The Virtual Machine Details Overview window appears. This window summarizes CPU and
memory usage for the domain(s) you specified.
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Domain-0 Virtual Machine Details

Virtual Machine Wiew

Over\new] Hardware |

Basic details =4

Mame:

uuiD:

Status: g Running

Performance

CPU usage: 1%

Memory usage: 926 MBE of 1022 MB

Figure 17.21. Displaying Virtual Machine Details Overview

3. On the Virtual Machine Details window, click the Hardware tab.

The Virtual Machine Details Hardware window appears.
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nl Domain-0 Virtual Machine Detaills

Virtual Machine WView

Overview Hardware‘
Processor @

Memaory

Disk N

Figure 17.22. Displaying Virtual Machine Details Hardware

On the Hardware tab, click on Processor to view or change the current processor memory
allocation.

Figure 17.23. Displaying Processor Allocation

On the Hardware tab, click on Memory to view or change the current RAM memory
allocation.

Owverview | Hardware |

Processor @

Memaory o, .

Disk O
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Figure 17.24. Displaying Memory Allocation

6. Onthe Hardware tab, click on Disk to view or change the current hard disk configuration.

Owverview | Hardware

Processor 0
Mermory 0

Metwork &

Figure 17.25. Displaying Disk Configuration

7. Onthe Hardware tab, click on Network to view or change the current network
configuration.

Overview | Hardware

Processor

=
Memory @
O

Disk

Metwork
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Figure 17.26. Displaying Network Configuration

10. Configuring Status Monitoring

You can use the Virtual Machine Manager to modify the virtual system Status monitoring.

To configure Status monitoring, and enable Consoles:

1. From the Edit menu, select Preferences.

b4 Virtual Machine Manager (Xen: localhost.localdomain)

File View Help

Host details... giew:[AlI virtual machines ¢l

¢ Machine details. ..
D CPU usage VCPUs Memory usage

3 Preferences

[ [@ New H &7 Details ” E}‘QpenJl

—

Figure 17.27. Modifying Virtual Machine Preferences

The Virtual Machine Manager Preferences window appears.

2. From the Status monitoring area selection box, specify the time (in seconds) that you want
the system to update.
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|'- = Virtual Machine Manager Prefe X

S5tatus monitoring

Update status every |1 a seconds

Consoles
Automatically open consoles:

For new domains =

Grab keyboard input:
.On mouse over =
¥ Close

Figure 17.28. Configuring Status Monitoring

3. From the Consoles area, specify how to open a console and specify an input device.

11. Displaying Domain ID

To view the domain IDs for all virtual machines on your system:

1. From the View menu, select the Domain ID check box.
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.

File Edit

Virtual Machine Manager -0

M Domain ID Eiew:| Al wvirtual machine

[]status
Mame -

[]CPU usage
Cvituai crus |

[IMemory usage
[]Disk usage
I Network traffic

[4] Il | »]

[+)!

'.':'?"L':'I':'t':' || ﬂew || fDEtE”E || 7 Open

Figure 17.29. Displaying Domain-IDs

2. The Virtual Machine Manager lists the Domain ID's for all domains on your system.

n. Virtual Machine Manager = |0 %

File Edit Miew Help

Eiew:| All wirtual machine =

[+

T Mame -

v
—t

(1] ] )
-,':':.'L-:—I-:—t-:— || ﬂew || fDetails || 7 Open |
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Figure 17.30. Displaying Domain-IDs

12. Displaying Virtual Machine Status

To view the status of all virtual machines on your system:

1. From the View menu, select the Status check box.

Virtual Machine Manager - 0O X
Fle Edit

ClDomain ID Eiew:[ |
B Status : —
[1CPU usage
ReaMERe [1virtual CPUs

[IMemory usage

e

&l i )
| || EHEW || &gDetails || =7 Open

Figure 17.31. Displaying Virtual Machine Status

2. The Virtual Machine Manager lists the status of all virtual machines on your system.
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n. Virtual Machine Manager | PN |
File Edit Miew Help

EiEW:| All virtual machines |

Mame ™ Status

Dormain-0 ‘ Running

[4] 11 | »]
| & Delete || [& New || Qf’Details || 7 Open

Figure 17.32. Displaying Virtual Machine Status

13. Displaying Virtual CPUs

To view the amount of virtual CPUs for all virtual machines on your system:

1. From the View menu, select the Virtual CPUs check box.
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2.

File Edit Help
[]Domain ID
[]Status
[]CPU usage

B Virtual CPUs

[IMemory usage
[ Disk usage
CINetwork traffic

All wirtual machine =

Wiew:

[+)!

Mame

I .‘

Figure 17.33. Displaying Virtual CPUs

The Virtual Machine Manager lists the Virtual CPUs for all virtual machines on your system.

n. Virtual Machine Manager = |0 [%
File Edit Miew Help

Eiew:| All wirtual machines | ¥

[+

Mame ™ VCPlUs
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Figure 17.34. Displaying Virtual CPUs

14. Displaying CPU Usage

To view the CPU usage for all virtual machines on your system:

1. From the View menu, select the CPU Usage check box.

Virtual Machine Manager - 0O X
Fle Edit | i=0 Help

[ lDomain ID Eiew:| |
[ status :

W CPU usage B

BLINERRYE [T virtual CPUs

[IMemory usage

&l i )
| || EHEW || &gDetails || =7 Open

Figure 17.35. Displaying CPU Usage

2. The Virtual Machine Manager lists the percentage of CPU in use for all virtual machines on
your system.
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. Virtual Machine Manager - | O
File Edit Miew Help

Eiew:| All virtual machines| =

Mame ¥ CPU usage

Comain-0 1.05 %

[ 11 [ v]

@ Delet: || ﬂew || Qf‘Details || 7 Open

Figure 17.36. Displaying CPU Usage

15. Displaying Memory Usage

To view the memory usage for all virtual machines on your system:

1.

From the View menu, select the Memory Usage check box.
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n. Virtual Machine Manager S | IR

Fle Edit pll=0 Help
[]Domain ID
[]Status
[]CPU usage
bl [1Virtual CPUs

Eiew:| All virtual machine =

[+)!

B Memory usage
[]Disk usage
I Network traffic

(4] i D
| @ Delete || [§ New || & Details || 7 Open

Figure 17.37. Displaying Memory Usage

2. The Virtual Machine Manager lists the percentage of memory in use (in megabytes) for all
virtual machines on your system.

. Virtual Machine Manager | PN |
File Edit View Help

e

Eiew:| All wirtual machines | 5

Marme ¥ Memory usage

Domain-0 926.37 ME (90.64%)
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Figure 17.38. Displaying Memory Usage

16. Managing a Virtual Network

To configure a virtual network on your system:

1. From the Edit menu, select Host Details.

b4 Virtual Machine Manager (Xen: localhost.localdomain)

File Wiew Help

Host details. ..

¢ Machine details. ..

giew:lAlI virtual machines ¢l

CPU usage VCPUs  Memory usage
1.85GB 92 %]|

3% Preferences

[ [& New H &7 Details ” E:;‘.?QpenJl

Figure 17.39. Selecting Host Details

2. This will open the Host Details menu. Click the Virtual Networks tab.
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File Help

Overview | Virtual Networks |

Basic details

default ‘i‘

Name: [default ]

UuID: [DElC9dd8—dc4?—43DD—9C42—D4QDQECED4EU

Device: [uirbr[] ]

State: g | Active
Autostart: & On boot

IPv4 configuration

Network: [192_153_122.0;24 ]

DHCP start: [192.168.122.2 ]

DHCP end: [192.168.122.254 ]

Forwarding: <@k NAT to any physical device

Figure 17.40. Virtual Network Configuration

3. All available virtual networks are listed on the left-hand box of the menu. You can edit the
configuration of a virtual network by selecting it from this box and editing as you see fit.

17. Creating a Virtual Network

To create a virtual network on your system:

1. Open the Host Details menu (refer to Section 16, “Managing a Virtual Network”) and click
the Add button.
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File Help

default ‘i‘

op Add

Overview | Virtual Networks |

Basic details

Name: [default

UuID: [DElC9dd8—dc4?—43DD—9C42—D4QDQECED4EU

Device: [virbr[]

State: g | Active
Autostart: & On boot

IPv4 configuration

Network: [192_153_122.0;24

DHCP start: [192.168.122.2

DHCP end: [192.168.122.254

Forwarding: <@k NAT to any physical device

Figure 17.41. Virtual Network Configuration

This will open the Create a new virtual network menu. Click Forward to continue.
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2.

Creating a new virtual network

This assistant will guide you through creating a new
virtual network. You will be asked for some information
about the virtual network you'd like to create, such as:

® A name for your new virtual network
® The IPvd address and netmask to assign
The address range from which the DHCP
® : : :
server will allocate addresses for virtual machines
® Whether to forward traffic to the physical network
|ﬁﬂelp‘ | b 4 Qancel| | =3 Eorward‘

Figure 17.42. Creating a new virtual network

Enter an appropriate name for your virtual network and click Forward.
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Naming your virtual network

Flease choose a name for your virtual netwaork:

Metwork Name: [netwnrkl

() Example: networkl

|ﬁ,ﬂelp‘ | b 4 Qancel| | < Eackz| | =3 Eorward‘

Figure 17.43. Naming your virtual network

3. Enter an IPv4 address space for your virtual network and click Forward.
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4.

Choosing an IPv4 address space

You will need to choose an IPvd address space
for the virtual network:

Network: [ ]

) Hint: The network should be choosen from one of
° the IPva private address ranges. eg 10.0.0.0/8,
172.16.0.0/12, or 192 168.0.0/16

MNetmask: 255.255.255.0
Broadcast: 192.168.100.255
Gateway: 192 168.100.1
SiZze: 256 addresses

Type: Private

|ﬁﬂelp‘ | b 4 Qancel| | < Eackz| | =3 Eorward‘

Figure 17.44. Choosing an IPv4 address space

Define the DHCP range for your virtual network by specifying a Start and End range of IP
addresses. Click Forward to continue.
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Selecting the DHCP range

Please choose the range of addresses the DHCP server can
use to allocate to guests attached to the virtual network

Start: | |

End: |:192.158.1EID.254 |

— Tip: Unless you wish to reserve some addresses to allow
static network configuration in virtual machines, these
parameters can be left with their default values.

|mﬂelp‘ | b 4 Qancel| | < Eackz| | =3 Eorward‘

Figure 17.45. Selecting the DHCP range

5. Select how the virtual network should connect to the physical network.
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Connecting to physical network

Flease indicate whether this virtual network
should be connected to the phyiscal network.

(@) lIsolated virtual network

() Forwarding to physical network

Desination:

|ﬁﬂelp‘ | b 4 Qancel| | < Eackz| | =3 Eorward‘

Figure 17.46. Connecting to physical network

If you select Forwarding to physical network, choose whether the Destination should be
NAT to any physical device or NAT to physical device ethO.

Click Forward to continue.

You are now ready to create the network. Check the configuration of your network and click
Finish.
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Ready to create network

Summary

Metwork name:

IPvd4 network

Metworl:
Gateway:
Metmask:

DHCP

Start address;
End address:

Forwarding

Connectivity:

B tep |

netwaorkl

192.168.100.0/24
192.168.100.1
255.255.255.0

192.168.100.128
192.168.100.254

Isolated wvirtual network

‘ b 4 gancel| ‘ <« Eack:‘ ‘éﬂfinish‘

Figure 17.47. Ready to create network

7. The new virtual network is now available in the Virtual Network tab of the Host Details

menu.
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File Help

networkl

default

Overview | Virtual Networks |

N

S\

op Add

Basic details

Mame: [networkl

UUID: [Ele595c6a—ZL6eD—?dgb—dcec—caeddﬂBCSEa

Device: [\met[]

State: Q:jActive
Autostart: & On boot

IPv4 configuration

Network: [192.158.100.0;24

DHCP start: [192.158.100.128

DHCP end: [192.168.100.254

Forwarding: @b Isolated virtual network

Figure 17.48. New virtual network is now available
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Chapter 18.

Red Hat Virtualization
Troubleshooting

This section covers potential issues you may experience in the installation, management, and
general day-to-day operations of your Red Hat Virtualization system(s). This troubleshooting
section covers the error messages, log file locations, system tools, and general approaches to
research data and analyze problems.

1. Logfile Overview and Locations

When deploying Red Hat Enterprise Linux 5.1 with Virtualization into your network
infrastructure, the host's Virtualization software uses many specific directories for important
configuration, log files, and other utilities. All the Red Hat Virtualization logs files are standard
ASCII files, and easily accessable with any ASCII based editor:

* The Red Hat Virtualization main configuration directory is / et ¢/ xen/ . This directory contains
the xend daemon and other virtual machine configuration files. The networking script files
reside here as well (in the / scri pt s subdirectory).

« All of actual log files themselves that you will consult for troubleshooting purposes reside in
the /var /| og/ xen directory.

* You should also know that the default directory for all virtual machine file-based disk images
resides in the / var /| i b/ xen directory.

* Red Hat Virtualization information for the / pr oc file system reside in the / proc/ xen/
directory.

2. Logfile Descriptions

Red Hat Virtualization features the xend daemon and genu- dm process, two utilities that write
the multiple log files to the / var /| og/ xen/ directory:

« xend. | og is the logdfile that contains all the data collected by the xend daemon, whether it is a
normal system event, or an operator initiated action. All virtual machine operations (such as
create, shutdown, destroy, etc.) appears here. The xend. | og is usually the first place to look
when you track down event or performance problems. It contains detailed entries and
conditions of the error messages.

« xend- debug. | og is the logfile that contains records of event errors from xend and the
Virtualization subsystems (such as framebuffer, Python scripts, etc.).
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xen- hot pl ug- | og is the logfile that contains data from hotplug events. If a device or a
network script does not come online, the event appears here.

gemu-dm [ PI D] . | og is the logfile created by the gemu- dmprocess for each fully virtualized
guest. When using this logfile, you must retrieve the given gemu- dm process PID, by using
the ps command to examine process arguments to isolate the gemu- dmprocess on the virtual
machine. Note that you must replace the [PID] symbol with the actual PID genu- dmprocess.

If you encounter any errors with the Virtual Machine Manager, you can review the generated
data in the vi rt - manager . | og file that resides in the /. vi rt - manager directory. Note that
every time you start the Virtual Machine Manager, it overwrites the existing logfile contents.
Make sure to backup the vi rt - manager . | og file, before you restart the Virtual Machine
manager after a system error.

3

. Important Directory Locations

There are additional utilities and logfiles you should remember when you track errors and
troubleshoot problems within Red Hat Virtualization environments:

Virtual machines images reside in the / var/ 1 i b/ xen/ i mages directory.

When you restart the xend daemon, it updates the xend- dat abase that resides in the
/var/lib/xen/ xend-db directory.

Virtual machine dumps (that you perform with xm dunp- core command) resides in the
/var/lib/xen/ dunps directory.

The / et c/ xen directory contains the configuration files that you use to manage system
resources. The xend daemon configuration file is called xend- confi g. sxp and you can use
this file to implement system-wide changes and configure the networking callouts.

The proc commands are another resource that allows you to gather system information.
These proc entries reside in the / pr oc/ xen directory:

/ proc/ xen/ capabi lities

[ proc/ xen/ bal | oon

/ proc/ xen/ xenbus/

4. Troubleshooting Tools
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This section summarizes the System Administrator applications, the networking utilities, and the
Advanced Debugging Tools (for more information on using these tools to configure the Red Hat
Virtualization services, see the respective configuration documentation). You can employ these
standard System Administrator Tools and logs to assist with troubleshooting:

e xentop

e xm dnesg
* xmlog

* vnst at

* jostat

e | sof

You can employ these Advanced Debugging Tools and logs to assist with troubleshooting:

e XenOprofile
* systemlap

e crash

* sysrq

* sysrq t

* sysrgq w

You can employ these Networking Tools to assist with troubleshooting:

e ifconfig

e tcpdunp

e brctl

brct! is a networking tool that inspects and configures the ethernet bridge configuration in the
Virtualization linux kernel. You must have root access before performing these example
commands:

# brctl show

bri dge- nanme bridge-id STP enabled interfaces
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xenbr 0 8000. feffffff no vif13.0
xenbr 1 8000. ffffefff yes pddunmy0
xenbr 2 8000.ffffffef no vif0.0

# brctl showracs xenbrO

port-no mac- addr | ocal ? agei ng timer
1 fe:ff:ff:ff:ff: yes 0. 00
2 fe:ff:ff:fe:ff: yes 0. 00

# brctl showstp xenbrO

xenbr 0

bri dge-id 8000. fefffffffff

desi gnat ed- r oot 8000. fefffffffff

root - port 0 pat h- cost 0
max- age 20. 00 bri dge- max- age 20. 00
hel l o-ti me 2.00 bri dge-hel l o-ti nme 2.00
f or war d- del ay 0. 00 bri dge-forward-delay 0.00
agei ng-ti ne 300. 01

hel | o-ti mer 1.43 ten-timer 0. 00
t opol ogy-change-timer 0.00 gc-tiner 0.02

5. Troubleshooting with the Logs

When encountering issues with installing Red Hat Virtualization, you can refer to the host
system's two logs to assist with troubleshooting. The xend. | og file contains the same basic
information as when you run the xm | og command. It resides in the / var /| og/ directory. Here
is an example log entry for when you create a domain running a kernel:

[ 2006- 12- 27 02:23: 02 xend] ERROR (SrvBase: 163) op=create: Error creating
domain: (0, 'Error')

Traceback (nobst recent call list)

File "/usr/lib/python2.4/site-packages/xen/ xend/ server/ SrvBase. py" |ine 107
in_performval = op_nethod (op,req)

File

"fusr/lib/python2. 4/site-packages/ xen/ xend/ server/ SrvDomai nDir.py line 71 in
op_create

rai se XendError ("Error creating domain: " + str(ex))

XendError: Error creating domain: (0, 'Error')
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The other log file, xend- debug. | og , is very useful to system administrators since it contains
even more detailed information than xend. | og . Here is the same error data for the same
kernel domain creation problem:

ERROR: WIIl only |oad images built for Xen v3.0

ERROR: Actually saw. GUEST_OS=net bsd, GUEST_VER=2.0, XEN VER=2.0;
LOADER=generi c, BSD_SYMIAB'

ERROR: Error constructing guest OS

When calling customer support, always include a copy of both these log files when contacting
the technical support staff.

6. Troubleshooting with the Serial Console

The serial console is helpful in troubleshooting difficult problems. If the Virtualization kernel
crashes and the hypervisor generates an error, there is no way to track the error on a local host.
However, the serial console allows you to capture it on a remote host. You must configure the
Xen host to output data to the serial console. Then you must configure the remote host to
capture the data. To do this, you must modify these options in the gr ub. conf file to enable a
38400-bps serial console on com1 / dev/tt yS0:

title Red Hat Enterprise Linix (2.6.18-8.2080_RHEL5xen0)

root (hdo, 2)

kernel /xen.gz-2.6.18-8.el5 coml=38400, 8nl

nmodul e /vm i nuz-2.618-8. el 5xen ro root =LABEL=/rhgb qui et
consol e=xvc consol e=tty xencons=xvc

nmodul e /initrd-2.6.18-8. el 5xen.iny

The sync_consol e can help determine a problem that causes hangs with asynchronous
hypervisor console output, and the " pnpacpi =of f * works around a problem that breaks input
on the serial console. The parameters " consol e=ttyS0" and "consol e=tty" means that
kernel errors get logged with on both the normal VGA console and on the serial console. Then
you can install and set up tt ywat ch to capture the data on a remote host connected by a
standard null-modem cable. For example, on the remote host you could type:

ttywat ch --name nyhost --port /dev/ttySO

This pipes the output from / dev/ tt yS0 into the file / var /1 og/ t t ywat ch/ nyhost .l og .

7. Paravirtualized Guest Console Access

Paravirtualized guest operating systems automatically has a virtual text console configured to
plumb data to the Domain0 operating system. You can do this from the command line by typing:
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xm consol e [ domai n name or nunber]

Where donai n100 represents a running name or number. You can also use the Virtual Machine
Manager to display the virtual text console. On the Virtual Machine Details window, select Serial
Console from the View menu.

8. Full Virtualization Guest Console Access

Full Virtualized guest operating systems automatically has a text console configured for use, but
the difference is the kernel guest is not configured. To enable the guest virtual serial console to
work with the Full Virtualized guest, you must modify the guest's gr ub. conf file, and include the
"consol e =ttyS0 consol e=tty0' parameter. This ensures that the kernel messages are sent
to the virtual serial console (and the normal graphical console). If you plan to use the virtual
serial console in a full virtualized guest, you must edit the configuration file in the / et ¢/ xen/
directory. On the host domain, you can then access the text console by typing:

xm consol e

You can also use the Virtual Machine Manager to display the serial console. On the Virtual
Machine Details window, select Serial Console from the View menu.

9. Implementing Lun Persistence

If your system is not using multipath, you can use udev to implement lun persistence. Before
implementing lun persistence in your system, ensure that you acquire the proper UUIDs. Once
you aquire these, you can configure lun persistence by editing the scsi _i d file that resides in

the / et ¢ directory. Once you have this file open in a text editor, you must comment out this
line:

# options=-b

Then replace it with this parameter:

# options=-g

This tells udev to monitor all system SCSI devices for returning UUIDs. To determine the
system UUIDs, type:

# scsi_id -g -s [/block/sdc
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The output should resemble the following:

[ root @levices] # scsi_id -g -s /bl ock/sdc
*3600a0b80001327510000015427b625e*

This long string of characters is the UUID. To get the device names to key off the UUID, check
each device path to ensure that the UUID number is the same for each device. The UUIDs do
not change when you add a new device to your system. Once you have checked the device
paths, you must create rules for the device naming. To create these rules, you must edit the
20- nares. r ul es file that resides in the / et ¢/ udev/ rul es. d directory. The device naming
rules you create here should follow this format:

# KERNEL="sd*", BUS="scsi", PROGRAM="sbin/scsi_id", RESULT="UU D',
NAVE=" devi cenane"

Replace your exisiting UUID and devicename with the above UUID retrieved entry. So the rule
should resemble the following:

KERNEL="sd*", BUS="scsi", PROGRAM="sbin/scsi _id",
RESULT="3600a0b80001327510000015427b625e
", NAME="nydevi cenane"

This causes the system to enable all devices that match / dev/ sd* to inspect the given UUID.
When it finds a matching device, it creates a device node called / dev/ devi cenane. For this
example, the device node is / dev/ mydevi ce . Finally, you need to append the rc. | ocal file
that resides in the / et ¢ directory with this path:

[ sbin/start_udev

IMPLEMENTING LUN PERSISTENCE WITH MULTIPATH

To implement lun persistence in a multipath environment, you must define the alias names for
the multipath devices. For this example, you must define four device aliases by editing the
mul ti pat h. conf file that resides in the / et c/ directory:

mul tipath {
wwi d 3600a0b80001327510000015427b625e
al i as oranpl

}

mul tipath {
wwi d 3600a0b80001327510000015427b6
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ali as or anp2

}

mul tipath {
wwi d 3600a0b80001327510000015427h625e
ali as or anp3

}

mul tipath {
wwi d 3600a0b80001327510000015427h625e
ali as or amp4

}

This defines 4 luns: / dev/ npat h/ or anp1l, / dev/ npat h/ or anp2, / dev/ npat h/ or anp3, and
dev/ npat h/ or anp4. The devices will reside in the / dev/ npat h directory. These lun names are
persistent over reboots as it creates the alias names on the wwid of the luns.

10. SELinux Considerations

This sections contains things to you must consider when you implement SELinux into your Red
Hat Virtualization environment. When you deploy system changes or add devices, you must
update your SELinux policy accordingly. To configure an LVM volume for a guest, you must
modify the SELinux context for the respective underlying block device and volume group.

# semanage fcontext -a -t xen_image _t -f -b /dev/sda2
# restorecon /dev/sda2

The boolean parameter xend_di sabl e_t r ans put xend in unconfined mode after restarting the
daemon. It is better to disable protection for a single daemon than the whole system. It is
advisable that you should not re-label directories as xen_i mage_t that you will use elsewhere.

11. Accessing Data on Guest Disk Image

You can use two separate applications that assist you in accessing data from within a guest
disk image. Before using these tools, you must shut down the guests. Accessing the file system
from the guest and domO could potentially harm your system.

You can use the kpartx application to handle partitioned disks or LVM volume groups:

yuminstall kpartx

kpartx -av /dev/xen/ guest 1

add map guestl1pl : 0 208782 |linear /dev/xen/guestl 63

add map guest1p2: 0 16563015 |inear /dev/xen/guestl 208845

To access LVM volumes on a second partiton, you must rescan LVM with vgscan and activate
the volume group on the partition (called VolGroup00 by default) by using the vgchange -ay
command:
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# kpartx -a /dev/xen/ guest1l

#vgscan

Readi ng al |l physical volumes . This may take a while..
Found vol ume group " Vol G oup00" using netadata type 1lvn®
# vgchange -ay Vol G oup00

2 |l ogical volunme(s) in volune group Vol G oup00 now acti ve.
# lvs

LV VG Attr Lsize Origin Snap% Move Log Copy%

LogVol 00 Vol G oup00 -wi-a- 5.06G

LogVol 01 Vol Group00 -wi -a- 800. 00M

# nmount /dev/ Vol G oup00/ LogVol 00 / mt/

#unount / mmt/

#vgchange -an Vol G- oup00
#kpartx -d /dev/xen/ guest 1

You must remember to deactivate the logical volumes with vgchange - an, remove the partitions
with kpartx-d , and delete the loop device with | oset up -d when you finish.

12. Common Troubleshooting Situations

When you attempt to start the xend service nothing happens. You type xm | i st 1 and receive
the following:

Error: Error connecting to xend: Connection refused. |Is xend runni ng?
You try to run xend st art manually and receive more errors:

Error: Could not obtain handle on privileged command interfaces (2 = No such
file or directory)

Traceback (nobst recent call last:)

File "/usr/sbin/xend/", line 33 in ?

from xen. xend. server. inport SrvDaenon

File "/usr/lib/python2. 4/site-packages/ xen/ xend/ server/ SrvDaenon. py" , |ine
26 in ?

from xen. xend i nport XendDomai n

File "/usr//1ib/python2.4/site-packages/ xen/ xend/ XendDomai n. py" , |ine 33
in ?

from xen. xend i mport XendDomai nl nf o
File "/usr/lib/python2. 4/site-packages/xen/xend/i mage. py" , line37, in ?

i nport i mages
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File "/usr/lib/python2.4/site-packages/ xen/ xend/ i mage. py" , 1ine30, in ?
xc = xen. | ow evel . xc. xc ()

Runti meError: (2, 'No such file or directory' )

What is most likely happened here is that you rebooted your host into a kernel that is not a
xen- hyper vi sor kernel. To correct this, you must select the xen- hyper vi sor kernel at boot
time (or set the xen- hyper vi sor kernel to default in your gr ub. conf file.

13. Loop Device Errors

If you use file-based guest images, one may have increased the number of configured loop
devices (the default allows up to 8 loop devices to become active). If you need more than 8
file-based guests/loop devices, you must modify the / et ¢/ modpr obe. conf file. When modifying
the nodpr obe. conf file, you must include this line:

opti ons | oop nmax_| oop=64

This example uses 64 but you can specify another number to set the maximum loop value. You
may also have to implement loop device backed guests on your system. To employ loop device
backed guests for a paravirtual system, use the phy: bl ock devi ce ortap: ai o commands.
To employ loop device backed guests for a full virtualized system, use the phy: device or
file: file commands.

14. Guest Creation Errors

When you attempt to create a guest, you receive an "I nval i d ar gument " error message. This
usually means that the kernel image you are trying to boot is incompatible with the hypervisor.
An example of this would be if you were attempting to run a non-PAE FC5 kernel on a PAE only
FC6 hypervisor.

You do a yum update and receive a new kernel, the gr ub. conf default kernel switches right
back to a bare-metal kernel instead of the Virtualization kernel.

To correct this problem you must modify the default kernel RPM that resides in the
/et c/ sysconfi g/ kernel/ directory. You must ensure that ker nel - xen parameter is set as the
default option in your gb. conf file.

15. Serial Console Errors

You receive no output to the serial console. To correct this problem, you must modify the
gr ub. conf and change the com port parameters to:
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serial --unit=1 --speed=115200

title RHELS i 386 Xen (2.6.18-1.2910. el 5xen)

root (hd0, 8)

kernel /boot/xen.gz-2.6.18-1.2910.el5 conk=115200, 8nl

nmodul e /boot/vm i nuz-2. 6. 18- 1. 2910. el 5xen to root =LABEL=RHEL5_i 386
consol e=tty consol e=ttyS1115200

nmodul e /boot/initrd-2.8.6.18-12910. el 5xen. i ngy

title RHELS i 386 xen (2.6.18.-1.2910. el 5xen

root (hd0, 8)

kernel /boot/xen.gz-2.6.18-1.2910.el5 conk=115200 consol e=con?|
nmodul e /boot/vm i nuz2. 6. 18- 1. 2910. el 5xen to r oot =LABEL=RHEL5 i 386
consol e=xvc Xxencons=Xxvc

nmodul e /boot/ititrd-2.6.18-1.2910. el 5xen. i ng

These changes to the gr ub. conf should enable your serial console to work correctly. You
should be able to use any number for the t t yS and it should work like tt yS0 .

16. Network Bridge Errors

Red Hat Virtualization can configure multiple Virtualization network bridges to use with multiple
ethernet cards. To successfully configure multiple network bridges for ethernet cards, you must
configure the second network interface by either using the system-config-network TUI/GUI, or
by creating a new configuration file in / et ¢/ sysconfi g/ net wor k- scri pts . You should use a
process to setup multiple Xen bridges. This is an example config file for a second NIC called
"ethl'

#/ et c/ sysconfi g/ network-scripts/fcfg-ethl
DEVI CE=et h1
BOOTPROTO=st at i ¢
ONBOOT=yes

USERCTL=no

| PV6I NI T=no
PEERDNS=yes

TYPE=Et her net
NETMASK=255. 255. 255. 0
| PADDR=10. 1. 1.1
GATEWAY=10. 1. 1. 254
ARP=yes

Copy the / et c/ xen/ scri pt s/ net wor k- bri dge to/etc/ xen/ scripts/ network-bridge. xen .

Edit/ et ¢/ xen/ xend- confi g. sxp and add a line to your new network bridge script (this
example uses "net wor k-vi rtual i zati on-mul ti-bridge" ).

In the xend- confi g. sxp file, the new line should reflect your new script:
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net wor k-scri pt network-xen-nul ti-bridge
Make sure to uncomment the line that states:
net wor k- scri pt networ k- bri dge

If you want to create multiple Xen bridges, you must create a custom script. This example below
creates two Xen bridges (called xenbr 0 and xenbr 1 ) and attaches them to et h1 and et hO ,
respectively:

# 1/ bin/sh

# networ k- xen-nul ti-bridge

# Exit if anything goes wong

set -e

# First arg is operation

OoP=%1

shift

script=/etc/xen/scripts/network-bridge. xen

case ${OP} in

start)

$script start vifnum=l bri dge=xenbr1 netdev=ethl
$script start vifnum=0 bri dge=xenbr0 net dev=et hO
st op)

$script stop vifnunrl bridge=xenbr1l netdev=ethl
$script stop vifnum=0 bri dge=xenbr0 netdev=et hO
st at us)

$script status vifnumel bri dge=xenbr1 netdev=et hl
$script status vifnum=O bri dge=xenbr 0 net dev=et hO
:

echo ' Unknown conmmand: ' ${OP}

echo 'Valid conmmands are: start, stop, status
exit 1

esac

If you want to create additional bridges, just use the example script and copy/paste the file
accordingly.

17. Laptop Configurations

The task of configuring your RHEL 5.1 loaded laptop for use on a network environment,
presents a number of potential challenges. Most WiFi and wired connections switch constantly
during any given day, and Red Hat Virtualization assumes it has access to the same interface
consistently. This results in the system performing ifup/ifdown calls to the network interface in
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use by Red Hat Virtualization. WiFi cards are not the ideal network connection method since
Red Hat Virtualization uses the default network interface.

The idea here is to create a 'dummy' network interface for Red Hat Virtualization to use.

This technique allows you to use a hidden IP address space for your guests and Virtual
Machines. To do this operation successfully, you must use static IP addresses as DHCP does
not listen for IP addresses on the dummy network. You also must configure NAT/IP
masquerading to enable network access for your guests and Virtual Machines. You should
attach a static IP when you create the 'dummy' network interface.

For this example, the interface is called dummyO and the IP used is 10.1.1.1 The script is called
i fcfg-dunmy0 and resides in the / et c/ sysconfi g/ net wor k-scri pts/ directory:

DEVI CE =dunmmy0
BOOTPROTO=none
ONBOOT=yes

USERCTL=no

| PV6I NI T=no
PEERDNS=yes

TYPE=Et her net
NETMASK=255. 255. 255. 0
| PADDR=10.1.1.1
ARP=yes

You should bind xenbr 0 to dunmy0 to allow network connection even when disconnected from
the physical network.

You will need to make additional modifications to the xend- confi g. sxp file. You must locate
the (network-script 'network-bridge' bridge=xenbr0 ) section and add include this in
the end of the line:

net dev=dumy0

You must also make some modifications to your guest's domU networking configuration to
enable the default gateway to point to dummyO. You must edit the DomU 'network’ file that
resides in the / et ¢/ sysconfi g/ directory to reflect the example below:

NETWORKI NG=yes
HOSTNAME=I ocal host . | ocal domai n
GATEWAY=10.1.1.1

| PADDR=10. 1. 1. 10
NETMASK=255. 255. 255. 0
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It is a good idea to enable NAT in domainO so that domU can access the public net. This way,

even wireless users can work around the Red Hat Virtualization wireless limitations. To do this,
you must modify the S99XenLapt opNAT file that resides in the / et ¢/ rc3. d directory to reflect

the example below:

#! / bi n/ bash

#

# XenLapt opNAT Startup script for Xen on Laptops
#

# chkconfig: - 99 01

# description: Start NAT for Xen Laptops

#

# PATH=/ usr/bi n:/sbin:/bin:/usr/sbin

# export PATH

GATEWAYDEV="ip route | grep default | awk {'print $5'}°

i ptables -F

case "$1" in

start)

if test -z "$GATEWAYDEV'; then

echo "No gateway device found”

el se

echo "Masquer adi ng usi ng $GATEWAYDEV"

/sbin/iptables -t nat -A POSTROUTI NG -0 $GATEWAYDEV -j MASQUERADE
fi

echo "Enabling IP forwardi ng"

echo 1 > /proc/sys/net/ipvé4/ip_forward

echo "IP forwarding set to "cat /proc/sys/net/ipv4/ip forward "
echo "done."

3

echo "Usage: $0 {start|restart]|status}"

esac

If you want to automatically have the network setup at boot time, you must create a softlink to
/etc/rc3. d/ S99XenLapt opNAT

When modifying the nodpr obe. conf file, you must include these lines:

alias dummyO dumy
opti ons dunmmy nundumm es=1

18. Starting Domains Automatically During System
Boot

Starting Domains Automatically During System Boot

You can configure your guests to start automatically when you boot the system. To do this, you
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must modify the symbolic links that resides in / et ¢/ xen/ aut o . This file points to the guest
configuration files that you need to start automatically. The startup process is serialized,
meaning that the higher the number of guests, the longer the boot process will take. This
example shows you how to use symbolic links for the guest r hel 5vn01 :

[ root @yt hon xen]# cd /etc/xen

[ root @yt hon xen]# cd auto

[root @yt hon auto]# |s

[root @ython auto]# In -s ../rhel 5vnD1 .
[ root @ython auto]# |s -

| rwxrwxrwx 1 root root 14 Dec 14 10: 02 rhel 5vnD1 -> ../rhel 5vnD1

[ root @yt hon aut o] #

19. Modifying DomainO

To use Red Hat Virtualization to manage domain0O, you will constantly making changes to the
grub. conf configuration file, that resides in the / et ¢ directory. Because of the large number of
domains to manage, many system administrators prefer to use the 'cut and paste' method when
editing gr ub. conf . If you do this, make sure that you include all five lines in the Virtualization
entry (or this will create system errors). If you require Xen hypervisor specific values, you must
add them to the 'xen' line. This example represents a correct gr ub. conf Virtualization entry:

# boot =/ dev/ sda/

def aul t =0

ti meout =15

#spl ashi mage=(hd0, 0)/grub/splash. xpm gz

hi ddennmenu
serial --unit=0 --speed=115200 --word=8 --parity=no --stop=1
termnal --tinmeout=10 serial console

title Red Hat Enterprise Linux Server (2.6.17-1.2519.4.21. el 5xen)
root (hdo, 0)
kernel /xen.gz-2.6.17-1.2519.4.21.el5 coml=115200, 8nl
nodul e /vm i nuz-2.6.17-1. 2519. 4. 21el 5xen ro

r oot =/ dev/ Vol G oup00/ LogVol 00
nmodul e /initrd-2.6.17-1.2519. 4. 21. el 5xen. i ng

For example, if you need to change your domO hypervisor's memory to 256MB at boot time, you
must edit the 'xen' line and append it with the correct entry, ' dond_nmem=256M . This example
represents the respective gr ub. conf xen entry:

# boot =/ dev/ sda

def aul t =0

ti meout =15

#spl ashi mage=(hd0, 0) / gr ubs/ spl ash. xpm gz
hi ddennenu
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serial --unit=0 --speed =115200 --word=8 --parity=no --stop=1
termnal --tinmeout=10 serial console
title Red Hat Enterprise Linux Server (2.6.17-1.2519.4.21. el 5xen)
root (hdo, 0)
kernel /xen.gz-2.6.17-1.2519.4.21.el5 com=115200, 8nl
donD_nenm=256MVB
nmodul e /vm i nuz-2.6.17-1. 2519. 4. 21. el 5xen ro
r oot =/ dev/ Vol G oup00/ LogVol 00
modul e /initrd-2.6.17-1.2519. 4. 21. el 5xen. i ny

20. Guest Configuration Files

When you install new guests using virt-manager (or virt-install) tool(s) from Red Hat Enterprise
Linux 5.1 with Virtualization, the guests configuration files (located in the /etc/xen directory) get
modified and setup automatically. This configuration file example is for a para-virtualized guest:

name = "rhel 5vnD1"

menory = "2048"

disk = ['tap:aio:/xen/images/rhel 5vnD1. dsk, xvda, W , |

vif = ["type=i eomu, nmac=00: 16: 3e: 09: f0: 12 bri dge=xenbr 0’
"type=i eonu, mac=00: 16: 3e: 09: f 0: 13 ]

vnc = 1

vhcunused = 1

uui d = "302bd9ce- 4f 60-f c67- 9e40- 7a77d9b4eled"

boot | oader = "/usr/ bi n/ pygrub”

vcpus=2
on_reboot = "restart"
on_crash = "restart"

Note that the seri al =" pty" is the default for the configuration file. This configuration file
example is for a fully-virtualized guest:

name = "rhel 5u5-86_64"

bui | der = "hvnt

menory = 500

disk = ['file:/xen/inmages/rhel 5u5-x86_64. dsk. hda, w

[../../../hone/ mideo/. evol ution//xen/images/rhel 5u5-x86_64. dsk. hda, w] ' ]
vif = [ 'type=i oenu, nmac=00: 16: 3e: 09: f 0: 12, bri dge=xenbr0Q', 'type=i eonu,
mac=00: 16: 3e: 09: f 0: 13, bri dge=xenbr1']

uui d = "b10372f 9- 91d7- ao5f - 12f f - 372100c99af 5'

devi ce_nodel = "/usr/l|ib64/xen/ bi n/ genu- dnt
kernel = "/usr/lib/xen/boot/hvm oader/"

vnc = 1

vncunused = 1

apic =1

acpi =1

pae = 1

vcpus =1

serial ="pty" # enable serial console
on_boot = 'restart’
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Cloning the Guest Configuration Files

21. Cloning the Guest Configuration Files

You can copy (or clone) an existing configuration file to create an all new guest. You must
modify the name parameter of the guests' configuration file. The new, unique name then
appears in the hypervisor and is viewable by the management utilities. You must generate an all
new UUID as well (using the uui dgen(1) command). Then for the vi f entries you must define
a unique MAC address for each guest (if you are copying a guest configuration from an existing
guest, you can create a script to handle it). For the xen bridge information, if you move an
existing guest configuration file to a new host, you must update the xenbr entry to match your
local networking configuration. For the Device entries, you must modify the entries in the

' di sk=" section to point to the correct guest image.

You must also modify these system configuration settings on your guest. You must modify the
HOSTNAME entry of the / et ¢/ sysconfi g/ net wor k file to match the new guest's hostname.

You must modify the HWADDR address of the
/ etc/ sysconfi g/ network-scripts/ifcfg-etho0 fileto match the output fromifconfig ethO
file and if you use static IP addresses, you must modify the IPADDR entry.

22. Creating a Script to Generate MAC Addresses

Red Hat Virtualization can generate a MAC address for each virtual machine at the time of
creation. Since is a nearly unlimited amount of numbers on the same subnet, it is unlikely you
could get the same MAC address. To work around this, you can also write a script to generate a
MAC address. This example script contains the parameters to generate a MAC address:

#! [ usr/ bi n/ pyt hon

# macgen. py script generates a MAC address for Xen guests
#

i nport random

mac = [ 0x00, 0x16, Ox3e,

random r andi nt (0x00, Ox7f),

random r andi nt (0x00, Oxff),

random r andi nt (0x00, Oxff) ]

print ':'.join(map(lanbda x: "%2x" % x, mac))

Cenerates e.g.:
00: 16: 3e: 66: f5: 77
to stdout

23. Configuring Virtual Machine Live Migration

Red Hat Virtualization can migrate virtual machines between other servers running Red Hat
Enterprise Linux 5.1 with Virtualization. Further, migration is performed in an offline method
(using the xm ni gr at e command). Live migration can be done from the same command.
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However there are some additional modifications that you must do to the xend- confi g
configuration file. This example identifies the entries that you must modify to ensure a
successful migration:

(xend-rel ocation-server yes)
The default for this parameter is 'no’, which keeps the relocation/migration server
deactivated (unless on a trusted network) and the domain virtual memory is exchanged in
raw form without encryption.

(xend-rel ocati on-port 8002)
This parameter sets the port that xend uses for migration. This value is correct, just make
sure to remove the comment that comes before it.

(xend-rel ocati on-address )
This parameter is the address that listens for relocation socket connections, after you
enable the xend-r el ocat i on-server .When listening, it restricts the migration to a
particular interface.

(xend-rel ocation-hosts-allow)
This parameter controls the host that communicates with the relocation port. If the value is
empty, then all incoming connections are allowed. You must change this to a
space-separated sequences of regular expressions (such as
xend-r el ocati on-hosts-all ow '”local host\\.|ocal domai n$' ). A host with a fully
qualified domain name or IP address that matches these expressions are accepted.

After you configure these parameters, you must reboot the host for the Red Hat Virtualization to
accept your new parameters.

24. Interpreting Error Messages

You receive the following error:
failed domain creation due to nenory shortage, unable to ball oon domai nO

A domain can fail if there is not enough RAM available. DomainO does not balloon down enough
to provide space for the newly created guest. You can check the xend. | og file for this error:

[ 2006- 12- 21] 20: 33: 31 xend 3198] DEBUG (bal | oon: 133) Bal | oon: 558432 Kib
free; 0 to scrub; need 1048576; retries: 20

[ 2006- 12-21] 20: 33: 31 xend. XendDommi nl nfo 3198] ERROR ( XendDonwmi nl nfo: 202
Domai n construction failed

You can check the amount of memory in use by domainO by using the xm | i st Donai n0
command. If domainO is not ballooned down, you can use the command " xm mem set
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Domai n-0 NewMenSi ze" to check memory.

You receive the following error:

wrong kernel inmage: non- PAE kernel on a PAE

This message indicates that you are trying to run an unsupported guest kernel image on your
Hypervisor. This happens when you try to boot a non-PAE paravirtual guest kernel on a RHEL
5.1 hypervisor. Red Hat Virtualization only supports guest kernels with PAE and 64bit
architectures.

Type this command:

[root@nith]# xmcreate -c va base

Using config file "va-base"

Error: (22, 'invalid argunent')

[ 2006- 12- 14 14:55: 46 xend. XendDomai nl nfo 3874] ERRORs
(XendDomai nl nf 0: 202) Domai n construction failed

Traceback (nost recent call |ast)

File "/usr/lib/python2.4/site-packages/ xen/ xend/ XendDonai nl nfo. py", |ine 195
in create vm i nit Domai n()

File " /usr/lib/python2.4/site-packages/xen/ xend/ XendDomai nl nfo. py", |ine

1363 in initDomain raise VnError(str(exn))

VnError: (22, 'Invalid argunent')

[ 2006- 12- 14 14:55: 46 xend. XendDonai nl nfo 3874] DEBUG ( XenDonmi nl nfo: 1449]
XendDl onai nl nf 0. destroy: dom n=1

[ 2006- 12- 14 14:55: 46 xend. XendDonmai nl nf o 3874] DEBUG ( XenDomai nl nf o: 1457]
XendDl omai nl nf 0. dest r oy: Donai n( 1)

If you need to run a 32bit/non-PAE kernel you will need to run your guest as a fully virtualized
virtual machine. For paravirtualized guests, if you need to run a 32bit PAE guest, then you must
have a 32bit PAE hypervisor. For paravirtualized guests, if you need to run a 64bit PAE guest,
then you must have a 64bit PAE hypervisor. For full virtulization guests you must run a 64bit
guest with a 64bit hypervisor. The 32bit PAE hypervisor that comes with RHEL 5 i686 only
supports running 32bit PAE paravirtualized and 32 bit fully virtualized guest OSes. The 64bit
hypervisor only supports 64bit paravirtualized guests.

This happens when you move the full virtualized HVM guest onto a RHEL 5.1 system. Your
guest may fail to boot and you will see an error in the console screen. Check the PAE entry in
your configuration file and ensure that pae=1.You should use a 32bit distibution.

You receive the following error:

Unabl e to open a connection to the Xen hypervi sor or daenon
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This happens when the virt-manager application fails to launch. This error occurs when there is
no localhost entry in the / et ¢/ host s configuration file. Check the file and verify if the localhost
entry is enabled. Here is an example of an incorrect localhost entry:

# Do not renpve the followi ng |line, or various prograns
# that require network functionality will fail.
| ocal host . | ocal domai n | ocal host

Here is an example of a correct localhost entry:

# Do not renpbve the followi ng |line, or various prograns
# that require network functionality will fail.
127.0.0.1 | ocal host. | ocal dormai n | ocal host

| ocal host . | ocal dormai n. | ocal host

You receive the following error (in the xen-xend. l og file ):

Bri dge xenbr1l does not exist!

This happens when the guest's bridge is incorrectly configured and this forces the Xen hotplug
scipts to timeout. If you move configuration files between hosts, you must ensure that you
update the guest configuration files to reflect network topology and configuration modifications.
When you attempt to start a guest that has an incorrect or non-existent Xen bridge
configuration, you will receive the following errors:

[root@runmble virt]# xmcreate r5b2-nySQL01

Using config file " r5b2-nmySQ.01"

Going to boot Red Hat Enterprise Linux Server (2.6.18.-1.2747 . el 5xen)
kernel : /vminuz-2.6.18-12747. el 5xen

initrd: /initrd-2.6.18-1.2747. el 5xen.ing

Error: Device O (vif) could not be connected. Hotplug scripts not working.

In addition, the xend. | og displays the following errors:

[ 2006- 11- 14 15:07: 08 xend 3875] DEBUG (DevControl | er:143) Waiting for
devi ces vif

[ 2006- 11-14 15:07: 08 xend 3875] DEBUG (DevControl |l er:149) Waiting for 0O
[ 2006- 11-14 15:07: 08 xend 3875] DEBUG (DevControl |l er: 464)

hot pl ugSt at usCal | back

/'l ocal / donmi n/ 0/ backend/ vi f/ 2/ 0/ hot pl ug- st at us
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[ 2006- 11-14 15:08: 09 xend. XendDonmai nl nfo 3875] DEBUG ( XendDonai nl nf 0: 1449)
XendDomai nl nf 0. destroy: dom d=2

[ 2006- 11- 14 15:08: 09 xend. XendDonmi nl nf o 3875] DEBUG ( XendDonmai nl nf 0: 1457)
XendDomai nl nf 0. dest r oyDomai n( 2)

[ 2006- 11-14 15:07: 08 xend 3875] DEBUG (DevControll er: 464)

hot pl ugSt at usCal | back

/'l ocal / domai n/ 0/ backend/ vi f/ 2/ 0/ hot pl ug- st at us

To resolve this problem, you must edit your guest configuration file, and modify the vi f entry.
When you locate the vi f entry of the configuration file, assuming you are using xenbr 0 as the
default bridge, ensure that the proper entry resembles the following:

# vif = ['mac=00: 16: 3e: 49: 1d: 11, bri dge=xenbr0', ]
You receive these python depreciation errors:

[ root @yt hon xen]# xm shut down wi n2k3xen12
[ root @yt hon xen]# xm create w n2k3xenl2

Using config file "w n2k3xenl2".

[usr/1ib64/ pyt hon2. 4/ si t e- packages/ xenxni opt s. py: 520: Deprecati on Warni ng:
Non ASCI| character '\xcO' in file wi n2k3xenl2 on line 1, but no encodi ng
decl ared; see http://ww. pyt hon. or g/ peps/ pep-0263. htl for details

execfile (defconfig, globs, |ocs,)
Error: invalid syntax 9w n2k3xenl12, |inel)

Python generates these messages when an invalid (or incorrect) configuration file. To resolve
this problem, you must modify the incorrect configuration file, or you can generate a new one.

25. Online Troubleshooting Resources
* Red Hat Virtualization Center
http://ww. openvirtualization.com[http://ww.openvirtualization.com]

* Red Hat Enterprise Linux 5 Beta 2 Documentation

http://ww.redhat.conm docs/ manual s/ ent er pri se/ RHEL- 5- manual /i ndex. ht ml

 Libvirt API
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Chapter 18. Red Hat Virtualization Troubleshooting

http://www [ ibvirt.org [http://wwlibvirt.org/]

« virt-manager Project Home Page

http://virt-manager.et.redhat.com [http://virt-manager. et.redhat.coni]

« Xen Community Center

http://ww. xensour ce. com xen/ xen/

« Virtualization Technologies Overview

http://virt.kernel newbies.org [http://virt.kernel newbi es. org/]

« Emerging Technologies Projects

http://et.redhat.com [http://et.redhat.com ]
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Chapter 19.

Additional Resources

To learn more about Red Hat Virtualization, refer to the following resources.

1. Useful Websites

* http://www.cl.cam.ac.uk/research/srg/netos/xen/ — The project website of the Xen™
para-virtualization machine manager from which Red Hat Virtualization is derived. The site
maintains the upstream Xen project binaries and sourcecode and also contains information,
architecture overviews, documentation, and related links regarding Xen and its associated
technologies.

 http://www.libvirt.org/ — The official website for the | i bvi rt virtualization API that interacts
with the virtualization framework of a host OS.

* http://virt-manager.et.redhat.com/ — The project website for the Virtual Machine Manager
(virt-manager), the graphical application for managing virtual machines.

2. Installed Documentation

e /usr/shar e/ doc/ xen- <ver si on- nunber > —. This directory contains a wealth of
information about the Xen para-virtualization hypervisor and associated management tools,
including a look at various example configurations, hardware-specific information, and the
current Xen upstream user documentation.

 man virsh and/usr/share/ doc/libvirt-<version-number >— Contains subcommands
and options for the vi r sh virtual machine management utility as well as comprehensive
information about the I i bvi rt virtualization library API.

e /usr/share/ doc/ gnome- appl et - vm <ver si on- nunber > — Documentation for the GNOME
graphical panel applet that monitors and manages locally-running virtual machines.

e /usr/share/doc/libvirt-python-<version- nunber > — Provides details on the Python
bindings for the | i bvi rt library. The | i bvi rt - pyt hon package allows python developers to
create programs that interface with the | i bvi rt virtualization management library.

e /usr/share/ doc/ pyt hon-virtinst-<versi on- nunber > — Provides documentation on the
virt-install command that helps in starting installations of Fedora and Red Hat Enterprise
Linux related distributions inside of virtual machines.

e /usr/share/doc/virt-nmanager - <ver si on- nunber > — Provides documentation on the
Virtual Machine Manager, which provides a graphical tool for administering virtual machines.
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Appendix A. Lab 1

Xen Guest Installation
Goal: To install RHEL 3, 4, or 5 and Windows XP Xen guests.

Prerequisites: A workstation installed with Red Hat Enterprise Linux 5.0 with Virtualization
component.

For this lab, you will configure and install RHEL 3, 4, or 5 and Win XP Xen guests using various
virtualization tools.

Lab Sequence 1: Checking for PAE support

You must determine whether your system has PAE support. Red Hat Virtualization supports
x86_64 or iab4 based CPU architectures to run para-virtualized guests. To run i386 guests the
system requires a CPU with PAE extensions. Many older laptops (particularly those based on
Pentium Mobile or Centrino) do not support PAE.

1. To determine if your CPU has PAE support, type:

grep pae /proc/cpuinfo

2. The following output shows a CPU that has PAE support. If the command returns nothing,
then the CPU does not have PAE support. All the lab exercises require a i386 CPU with PAE
extension or x86_64 or ia64 in order to proceed.

flags :

fpu vme de pse tsc nsr pae nte cx8 apic ntrr pge ncta cnov pat clflush
dts acpi

mx fxsr sse sse2 ss tm pbe nx up est tnR

Lab Sequence 2: Installing RHEL5 Beta 2 Xen para-virtualized guest using virt-instal | .

For this lab, you must install a Red Hat Enterprise Linux 5 Beta 2 Xen guest using
virt-install.

1. To install your Red Hat Enterprise Linux 5 Beta 2 Xen guest, at the command prompt type:
virt-install.

2. When asked to install a fully virtualized guest, type: no.
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8.

9

. Type r hel 5b2- pv1 for your virtual machine name.

. Type 500 for your RAM allocation.

. Type / xen/ rhel 5b2-pv1.inmg for your disk (guest image).

. Type 6 for the size of your disk (guest image).

. Type yes to enable graphics support.

Type nf s: server:/ pat h/t o/ r hel 5b2 for your install location.

. The installation begins. Proceed as normal with the installation.

10After the installation completes, type / et ¢/ xen/ r hel 5b2- pv1, and make the following

1

changes: #vnc=1#vncunused=1sdl=1

1Use a text editor to modify / et ¢/ i ni tt ab, and append this to the file: i ni t
5.#id:3:initdefault:id:5:initdefault:

Lab Sequence 3: Installing RHEL5 Beta 2 Xen para-virtualized guest using vi rt - manager .

F

or this lab, you will install a Red Hat Enterprise Linux 5 Beta 2 Xen paravirtualized guest using

vi rt - manager.

9.

. To install your Red Hat Enterprise Linux 5 Beta 2 Xen guest, at the command prompt type:
vi rt - manager.

. On the Open Connection window, select Local Xen host, and click on Connect.

. Start Red Hat's Virtual Machine Manager application, and from the File menu, click on New.
. Click on Forward.

. Type r hel 5b2- pv2 for your system name, and click on Forward.

. Select Paravirtualized, and click Forward.

. Type nf s: server:/ pat h/t o/ r hel 5b2 for your install media URL, and click Forward.

. Select Si npl e Fil e, type / xen/ r hel 5b2-pv2.inmg for your file location. Choose 6000 MB,
and click Forward.

Choose 500 for your VM Startup and Maximum Memory, and click Forward.

10Click Finish.

T

he Virtual Machine Console window appears. Proceed as normal and finish up the installation.

Lab Sequence 4: Checking for Intel-VT or AMD-V support
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For this lab, you must determine if your system supports Intel-VT or AMD-V hardware. Your
system must support Intel-VT or AMD-V enabled CPUs to successfully install the fully virtualized
guest operating systems. Red Hat Virtualization incorporates a generic HVM layer to support
these CPU vendors.

1. To determine if your CPU has Intel-VT or AMD-V support, type the following command:
egrep -e 'vnx|svm /proc/cpuinfo

2. The following output shows a CPU that supports Intel-VT:
.flags :
fpu tsc nmsr pae nte cx8 apic nmtrr nca cnov pat clflush dts acpi mmx fxsr

sse
sse2 ss ht tm pbe constant_tsc pni nonitor vnx est tn2 xtpr

If the command returns nothing, then the CPU does not support Intel-VT or AMD-V.

3. To determine if your CPU has Intel-VT or AMD-V support, type the following command:

cat /sys/ hypervisor/properties/capabilities

4. The following output shows that Intel-VT support has been enabled in the BIOS. If the
command returns nothing, then go into the BIOS Setup Utlility and look for a setting related to
'Virtualization', i.e. 'Intel(R) Virtualization Technology' under 'CPU' section on a IBM T60p.
Enable and save the setting and do a power off to take effect.

xen- 3. 0-x86_32p hvm 3. 0- x86_32 hvm 3. 0- x86_32p

Lab Sequence 5: Installing RHEL5 Beta 2 Xen fully virtualized guest using virt-install.

For this lab, you will install a Red Hat Enterprise Linux 5 Beta 2 Xen fully virtualized guest using
virt-install:

1. To install your Red Hat Enterprise Linux 5 Beta 2 Xen guest, at the command prompt type:
virt-install.

2. When prompted to install a fully virtualized guest, type yes.
3. Type r hel 5b2- pv2 for your virtual machine name.

4. Type 500 for your memory allocation.
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. Type / xen/ r hel 5b2-f v1. i ng for your disk (guest image).
. Type 6 for the size of your disk (guest image).

. Type yes to enable graphics support.

. Type / dev/ cdr omfor the virtual CD image.

. The VNC viewer appears within the installation window. If there is an error message that

says “main: Unable to connect to host: Connection refused (111)", then type the following
command to proceed: vncvi ewer | ocal host: 5900. VNC port 5900 refers to the first Xen
guest that is running on VNC. If it doesn't work, you might need to use 5901, 5902, etc.

The installation begins. Proceed as normal with the installation.

Lab Sequence 6: Installing RHEL5 Beta 2 Xen fully virtualized guest using virt-manager.

For this lab, you will install a Red Hat Enterprise Linux 5 Beta 2 Xen fully virtualized guest using
vi rt-manager:

1. To install your Red Hat Enterprise Linux 5 Beta 2 Xen guest, at the command prompt type:
vi rt - manager.

2. On the Open Connection window, select Local Xen host, and click on Connect.

3. Start Red Hat's Virtual Machine Monitor application, and from the File menu, click on New.

4. Click on Forward.

5. Type r hel 5b2- f v2 for your system name, and click on Forward.

6. Select Fully virtualized, and click Forward.

7. Specify either CD-ROM or DVD, and enter the path to install media. Specify ISO Image
location if you will install from an ISO image. Click Forward.

8. Select Simple File, type / xen/ r hel 5b2-fv2. i ng for your file location. Specify 6000 MB, and
click Forward.

9. Choose 500 for your VM Startup and Maximum Memory, and click Forward.

10Click Finish .

11The Virtual Machine Console window appears.

Proceed as normal and finish up the installation.

Lab Sequence 7: Installing RHEL3 Xen fully virtualized guest using vi rt - manager .

For this lab, you will install a Red Hat Enterprise Linux 3 Xen guest using vi rt - manager :
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1. The same instructions for Lab Sequence 6 applies here.
Lab Sequence 8: Installing RHEL4 Xen fully virtualized guest using vi rt - manager

For this lab, you will install a Red Hat Enterprise Linux 4 Xen guest using vi rt - manager

1. The same instructions for Lab Sequence 6 applies here.
Lab Sequence 9: Installing Windows XP Xen fully virtualized guest using vi rt - manager .

For this lab, you will install a Windows XP Xen fully virtualized guest using vi rt - manager :

1. To install your Red Hat Enterprise Linux 5 on your Windows XP host, at the command
prompt type: vi rt - nanager .

2. On the Open Connection window, select Local Xen host, and click on Connect.

3. Start Red Hat's Virtual Machine Manager application, and from the File menu click on New.
4. Click on Forward.

5. Type wi nxp for your system name, and click on Forward.

6. Select Fully virtualized, and click Forward.

7. Specify either CD-ROM or DVD, and enter the path to install media. Specify ISO Image
location if you will install from an ISO image. Click Forward.

8. Select Simple File, type / xen/ wi nxp. i mg for your file location. Specify 6000 MB, and click
Forward.

9. Select 1024 for your VM Startup and Maximum Memory, and select 2 for VCPUs. Click
Forward .

10Click Finish.

11The Virtual Machine Console window appears. Proceed as normal and finish up the
installation.

12Choose to format the C:\ patrtition in FAT file system format. Red Hat Enterprise Linux 5
does not come with NTFS kernel modules. Mounting or writing files to the Xen guest image
may not be as straight-forward if you were to format the partition in NTFS file system format.

13After you reboot the system for the first time, edit the wi nxp guest image: | oset up
/ dev/ |1 oop0 /xen/w nxp.ingkpartx -av /dev/| oopOnount /dev/mapper/| oopOpl
/mtcp -prv $W NDOWS/ i 386 / mt /. This fixes a problem that you may face in the later
part of the Windows installation.

14 Restart the Xen guest manually by typing: xm create -c wi nxp/.
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151n the Virtual Machine Manager window, select the wi nxp Xen guest and click Open.

16The Virtual Machine Console window appears. Proceed as normal and finish up with the
installation.

17Whenever a 'Files Needed' dialog box appears, change the path
GLOBALROOT\ DEVI CE\ CDROWD\ | 386 to C:\ | 386. Depending on your installation, you may or
may not see this problem. You may be prompted for missing files during the installation.
Changing the path to C:\ 1 386 should compensate for this problem.

18If the Xen guest console freezes, click shut down, make the following changes in
[ et c/ xen/ wi nxp: #vnc=1#vncunused=1sdl =1#vcpus=2

19Repeat step 14 and proceed as normal with the installation.
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Live Migration

Goal: To configure and perform a live migration between two hosts.

Prerequisite: Two workstations installed with Red Hat Enterprise Linux 5.0 Beta 2 with
Virtualization Platform, and a Fedora Core 6 Xen guest on one of the two workstations.

For this lab, you will configure the migration and execute a live migration between two hosts.

Introduction: Before you begin

For this lab, you will need two Virtualization hosts: a Xen guest and a shared storage. You must
connect the two Virtualization hosts via a UTP cable. One of the Virtualization hosts exports a
shared storage via NFS. You must configure both of the Virtualization hosts so they migrate
successfully. The Xen guest resides on the shared storage. On the Xen guest, you should
install a streaming server. You must make sure that the streaming server still runs without any
interruptions on the Xen guest, so the live migration takes place between one Virtualization host
and the other. For Lab 2, you will refer the two Virtualization hosts as host 1 and host 2 .

Sequence 1: Configuring xend (both Xen hosts)

In this Lab procedure, you configure xend to start up as a HTTP server and a relocation server.
The xend daemon does not initiate the HTTP server by default. It starts the UNIX domain socket
management server (for xm) and communicates with xend. To enable cross-machine live
migration, you must configure it to support live migration:

1. To make a backup of your xend- confi g. sxp file:

cp -pr /etc/xen/ xend-config.sxp /etc/xen/xend-config.sxp.default

2. Edit/etc/ xen/ xend- confi g. sxp and make the following changes:

#(xend- uni x-server yes)(xend-rel ocati on-server
yes) (xend-rel ocati on-port 8002) (xend-rel ocati on-address
"')(xend-rel ocation-hosts-allow '"')#(xend-rel ocation-hosts-allow
'l ocal host $
Al ocal host\\. | ocal domai n$')
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3. Restart xend: service and xend restart.

Sequence 2: Exporting a shared storage via NFS

For this lab procedure, you will configure NFS and use it to export a shared storage.

1. Edit/etc/exports and include the line: / xen *(rw, sync, no_r oot _squash)/

2. Save/etc/exports and restart the NFS server. Make sure that the NFS server starts by
defaul t:service nfs startchkconfig nfs on.

3. After starting the NFS server on host 1, we can then mount it on host 2: nount host 1: / xen

4. Now start the Xen guest on host 1 and select f c6- pvl (or f c6-pv2 from Lab 1):

xm create -c fc6-pvl

Sequence 3: Installing the Xen guest streaming server

For this lab step, you will install a streaming server, gnump3d, for our demonstration purposes.
You will select gnump3d because it supports OGG vorbis files and is easy to install, configure,
and modify.

1. Download gnunp3d-2.9.9.9.tar. bz2 tarball from htt p: / / www. gnunp3d. or g/ . Unpack
the tarball and in the gnunp3d- 2. 9. 9. 9/ directory, compile, and install the gnunp3d
application:tar xvjf gnunmp3d-2.9.9.9.tar.bz2cd gnunp3d-2.9.9. 9/ make install

2. Create a/ hone/ np3 directory and copy TruthHappens.ogg from Red Hat's Truth Happens
page to nkdi r /home/ np3wget -c http://ww. redhat. conif v/ ogg/ Tr ut hHappens. ogg

3. Start the streaming server by typing

conmmand: gnunp3d

4. On either one of the two Xen hosts, start running the Movie Player. If it is not installed, then
install the totem and iso-codecs rpms before running the Movie Player. Click Applications,
then Sound & Video, and finally Movie Player.
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5. Click Movie, then Open Location. Enter http://guest:8888/TruthHappens.ogg.

Sequence 4: Performing live migration

1. Run the Trut hHappens. ogg file on one of the two Xen hosts.

2. Perform the live migration from host 1 to host 2:

xm mgrate —live fc6-pvl host2

3.  Open multiple window terminals on both Xen hosts with the following command:

watch -nl1 xmli st

4. Observe as the live migration beginss. Note how long it takes for migration to complete.

Challenge Sequence: Configuring VNC server from within the Xen guest

If time permits, from within the Xen guest, configure the VNC server to initiate when gdmstarts
up. Run VNC viewer and connect to the Xen guest. Play with the Xen guest when the live
migration occurs. Attempt to pause/resume, and save/restore the Xen guest and observe what
happens to the VNC viewer. If you connect to the VNC viewer via | ocal host : 590x, and do a
live migration, you won't be able to connect to the VNC viewer again when it dies. This is a
known bug.
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